
Dell™ Laser Printer 1710/1710n

Owner’s Manual
Look Inside For:
• Setting Up Your Printer

• Loading Paper

• Network Printing

• Understanding the Software
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Ordering Supplies
Dell™ print cartridges are available only through Dell. You can order print cartridges online at 
www.dell.com/supplies or by phone. 

 NOTE: If your country is not listed, contact your Dell distributor to order supplies.

Your printer has been designed to print using the following print cartridges.

US 877-INK-2-YOU Luxembourg 02.713 1590

Australia 1300 303 290 Malaysia 1800 88 0301

Austria 08 20 - 24 05 30 35 Mexico 001 866 851 1754

Belgium 02.713 1590 Netherlands 020 - 674 4881

Canada 877-501-4803 Norway 231622 64

Chile 1230-020-3947 

800-202874

Portugal 21 4220710

PRC 800-858-0888

Colombia 01800-9-155676 Poland 022 579 59 65

Czech +420 225 372 711 Puerto Rico 866-851-1760

Denmark 3287 5215 Singapore 1800 394 7486

Finland 09 2533 1411 South Africa 0860 102 591

France 825387247 Spain 902120385

Germany 0800 2873355 Sweden 08 587 705 81

Ireland 1850 707 407 Switzerland 0848 335 599

Italy 800602705 UK 0870 907 4574

Japan 044-556-3551

Supply Item Part number

3,000 page toner cartridge N3769

3,000 page Use and Return toner cartridge J3815

6,000 page toner cartridge H3730

6,000 page Use and Return toner cartridge K3756

30,000 page Imaging drum D4283



Notes, Notices, and Cautions
 NOTE: A NOTE indicates important information that helps you make better use of your printer.

 NOTICE: A NOTICE indicates either potential damage to hardware or loss of data and tells you how 
to avoid the problem.

 CAUTION: A CAUTION indicates a potential for property damage, personal injury, or 
death.

____________________

Information in this document is subject to change without notice.
© 2005 Dell Inc. All rights reserved.

Reproduction in any manner whatsoever without the written permission of Dell Inc. is strictly forbidden.

Trademarks used in this text: Dell and the DELL logo are trademarks of Dell Inc.; Microsoft and Windows are registered 
trademarks of Microsoft Corporation.

Other trademarks and trade names may be used in this document to refer to either the entities claiming the marks and names 
or their products. Dell Inc. disclaims any proprietary interest in trademarks and trade names other than its own.

UNITED STATES GOVERNMENT RESTRICTED RIGHTS
This software and documentation are provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the Government 
is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause 
at DFARS 252.227-7013 and in applicable FAR provisions: Dell Inc., One Dell Way, Round Rock, Texas, 78682, USA.

FCC emissions information 

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC 
rules. Refer to the Drivers and Utilities CD for details.
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 CAUTION: SAFETY INSTRUCTIONS
Use the following safety guidelines to help ensure your own personal safety and to help protect your 
product and working environment from potential damage.

• Do not use your printer in a wet environment, for example, near a bath tub, sink, or swimming pool 
or in a wet basement.

• Ensure that nothing rests on your product’s cables and that the cables are not located where they can 
be stepped on or tripped over.

• Use only the power cable provided with this product or the manufacturer’s authorized replacement 
power cable.

 CAUTION: If your product is not marked with this symbol , it must be connected 
to an electrical outlet that is properly grounded.

• Connect the power cable to an electrical outlet that is near the product and easily accessible.

• To completely turn off the product, the power cable must be removed from the power source.

• Refer service or repairs, other than those described in the user documentation, to a professional 
service person.

• This product is designed to meet safety standards with the use of specific Dell-authorized 
components. The safety features of some parts may not always be obvious. Dell disclaims liability 
associated with the use of non-Dell-authorized components.

• Refer to your Owner’s Manual for instructions on the proper way to clear paper jams.

• Your product uses a laser.

 CAUTION: Use of controls or adjustments or performance of procedures other than 
those specified herein may result in hazardous radiation exposure.

• Your product uses a printing process that heats the print media, and heat can cause certain media to 
release emissions. You must understand the section in your operating instructions that discusses the 
guidelines for selecting appropriate print media to avoid the possibility of harmful emissions.

 CAUTION: Laser Safety

• This printer is certified as a “Class 1” laser product under the U.S. Department of Health and 
Human Services (DHHS) Radiation Performance Standard according to the Radiation Control for 
Health and Safety Act of 1968.

• Since radiation emitted inside the printer is confined within protective housings and external covers, 
the laser beam cannot escape during normal user operation.
CAUTION: SAFETY INSTRUCTIONS 9
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1

Getting Started
Understanding Your Printer

1 Optional 550-sheet tray 5 Output bin

2 250-sheet tray 6 Operator panel

3 Manual feed slot 7 Front cover

4 Paper guide

2

3

5

6

7
1

4

Getting Started 11
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 Using the Operator Panel Buttons

The operator panel has five lights and two buttons.

• Press and release Continue  to resume printing.

• Press and release Continue  twice quickly to display an error code.

• Press and release Cancel  to cancel the job currently printing.

• Press and hold Cancel  until all of the lights come on to reset the printer.

Printing the Printer Settings Configuration Sheet
To print the Printer Settings Configuration sheet:

1 Turn the printer off.

2 Open the upper front door.

3 Press and hold Continue  as you turn the printer on.

All the lights cycle.
12 Getting Started



4 Release Continue .

5 Close the upper front door.

The light sequence that represents the Home menu is displayed.

6 Press and release Continue  until all the lights cycle.

A Printer Settings Configuration sheet prints.

Installing the 550-Sheet Optional Drawer
Your printer supports one optional drawer that lets you load up to 550 sheets of paper.

 CAUTION: If you are installing a 550-sheet drawer after setting up the printer, turn 
the printer off and unplug the power cord before continuing.

1 Unpack the 550-sheet drawer and remove any packing material.

2 Place the drawer in the location you have chosen for your printer.

 NOTE: If you have optional memory to install, leave clearance on the right side of the printer.

3 Align the holes in the printer with the positioning posts on the 550-sheet drawer and lower 
the printer into place.
Getting Started 13
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 Specifying the media type and size loaded into each tray will help prevent jams. See 

"Configuring the Paper Trays" on page 14 for more information.

Configuring the Paper Trays

 NOTE: You must first install the drivers for your printer before configuring the paper trays. See 
"Setting Up for Local Printing" on page 27 or "Setting Up for Network Printing" on page 37.

Dell Laser Printer 1710/1710n

1 Launch the Dell Local Printer Settings Utility by clicking Start→Programs→Dell 
Printers→Dell Laser Printer 1710→Dell Local Printer Settings Utility.

2 Select your Dell Laser Printer 1710.

3 Click OK.

4 In the left column, click Paper.

5 In the right column, go to the Tray 1 section.  Specify what size and type of media you 
loaded into tray 1.

6 In the right column, go to the Tray 2 section.  Specify what size and type of media you 
loaded into tray 2.

7 On the Menu Bar, click Actions→Apply Settings.

8 Close the utility.

 NOTE: If you change the size or type of media loaded into either tray, use the Local Printer Settings 
Utility to reconfigure the tray.

9 To update your printer options, follow the instructions in the table.

Windows XP 1 Click Start→Control Panel→Printers and Other Hardware→Printers and 
Faxes. 

2 Right-click the Dell Laser Printer 1710 icon. 
3 Click Properties→Installed Options→Ask Printer.

4 Click OK→OK. Close the Printers folder. 

Windows 2000
Windows NT 4.0

1 Click Start→Settings→Printers. 
2 Right-click the Dell Laser Printer 1710 icon. 
3 Click Properties→Installed Options (or Options)→Ask Printer (or Update 

Now).
4 Click OK→OK. Close the Printers folder.
14 Getting Started



If Update or Ask Printer is unavailable, follow these steps:

a In the Available Options list, click 550-sheet tray. 

b Click Add.

c Click OK, and then close the Printers folder.

If Update Now or Ask Printer is unavailable, follow these steps:

a In the Options list, find 550-sheet tray. 

b Change the setting from Not Installed to Installed. 

c Click OK, and then close the Printers folder.

Dell Laser Printer 1710n

Setting the paper size and type for the 1710n printer is done through the Dell Printer 
Configuration Web Tool.

Use the following steps to change the 1710n printer paper size and type:

1 Type your network printer’s IP address in your Web browser.

 NOTE: If you do not know what your printer’s IP address is, print a network setup page, which lists 
the IP address. For more information, see "Print and Check the Network Setup Page" on page 37.

2 When the Printer Status page appears, select Printer Settings in the left column.

3 Select Paper Menu from the Printer Settings page.

4 Select PAPER SIZE.

5 Select the paper size you have in each tray.

6 Click Submit.

7 Select Printer Settings in the left column.

8 Select Paper Menu from the Printer Settings page.

9 Select PAPER TYPE.

10 Select the paper type you have in each tray.

11 Click Submit.

Windows Me
Windows 98 SE

1 Click Start→Settings→Printers. 
2 Right-click the Dell Laser Printer 1710 icon. 
3 Click Properties→Device (or Features)→Update (or Update Now).
4 Click OK→OK. Close the Printers folder.
Getting Started 15
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 Installing an Optional Memory Card

The system board has one connector for an optional memory card. The printer can support up 
to 128MB (for a total of 160MB for a network printer and 144MB for a non-network printer).

 CAUTION: If you are installing a memory card after setting up the printer, turn the 
printer off and unplug the power cord before continuing.

1 Open the front cover by pressing the button on the left side of the printer and lowering the 
cover.

2 Open the rear exit.
16 Getting Started



3 Open the side cover by pressing the two detents on the front right side of the machine and 
swinging the cover back.

4 Push open the latches on both ends of the memory connector.

 NOTE: Memory options designed for other printers may not work with your printer.

5 Unpack the memory card.

 NOTICE: Memory cards are easily damaged by static electricity. Touch something metal, such as the 
printer frame, before you touch a memory card.

Avoid touching the connection points along the edge of the card.
Getting Started 17
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 6 Align the notches on the bottom of the card with the notches on the connector.

7 Push the memory card firmly into the connector until the latches on either end of the 
connector snap into place.

It may require some force to fully seat the card.

8 Make sure each latch fits over the notch on each end of the card.

9 Close the side cover.

10 Close the rear exit.

11 Close the front cover.

12 To update your printer options, follow these instructions:

a For Windows XP, click Start→Control Panel→Printers and Other Hardware→Printers and 
Faxes. 

For all others, click Start→Settings→Printers. 

b Right-click the Dell Laser Printer 1710 icon, and then select Properties.

c On the Install Options tab, increase the amount of memory in the Printer Memory 
(MB) box.

d Click OK.
18 Getting Started



2

Loading Paper
Loading the 250-Sheet and 550-Sheet Trays
Follow these instructions to load paper in the 250-sheet tray and 550-sheet tray.

1 Remove the tray.

 2 Prepare a stack of paper for loading by flexing or fanning it back and forth. Straighten the 
edges on a level surface.
Loading Paper 19
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 3 Load the paper in the tray with the print side facing down.

Make sure the paper is below the max fill line on the side guides. Overloading may cause 
jams.

4 Slide the two side guides and the back guide until they fit snugly against the stack of paper.

If you are loading legal or folio size paper, press down on the latch at the back of the tray 
and expand the tray until the extender locks into place.
20 Loading Paper



5 Insert the tray. 

6 Extend the paper support on the output bin.
Loading Paper 21
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 Loading the Manual Feeder

The manual feeder is located at the front of your printer and can only feed one sheet of print 
media at a time. You can use the manual feeder to make quick runs of paper types or sizes that 
are not currently loaded in the paper tray.

To load the manual feeder:

1 Place a sheet of the selected print media, print side facing up, at the center of the manual 
feeder, but only to the point where its leading edge can contact the paper guides. 
Otherwise, the printer will engage the print media too soon and skew the print job.

2 Adjust the paper guides to the print media’s width.

3 Hold both sides of the print media close to the manual feeder and push it into the printer 
until it automatically engages.

There is a brief pause between the time the printer engages the print media and when it 
feeds into the printer.
22 Loading Paper



 NOTICE: Do not force the print media into the feeder. Forcing the media causes jams.

• Insert envelopes with the flap side face down and with the stamp area on the top right 
side.

• Hold transparencies by the edges and avoid touching the print side. Oils from your 
fingers that are deposited on the transparency can affect print quality.

• Load letterhead face-up, with the top of the sheet entering the printer first.

• If you experience problems with paper feed, turn the paper around.

Using the Rear Exit
The single-sheet rear exit provides a straight-through paper path to help reduce curling and 
potential jams. This is especially useful for specialty media, such as transparencies, envelopes, 
labels, card stock, or index cards.

To use the rear exit, simply open the rear exit door. When the rear exit door is open, all print 
media comes out the rear exit. When closed, all media is sent to the output bin on top of the 
printer.
Loading Paper 23
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 Print Media Guidelines

Selecting the right paper or other media reduces printing problems. For best print quality, try a 
sample of the paper or specialty media you are considering before buying large quantities.

 CAUTION: Your product uses a printing process that heats the print media, and heat 
can cause certain media to release emissions. You must understand the section in 
your operating instructions that discusses the guidelines for selecting appropriate 
print media to avoid the possibility of harmful emissions.

• Use 20 lb (75 g/m2) xerographic paper.

• Use transparencies designed for laser printers.

• Use paper labels designed for laser printers.

• Use envelopes made from 24 lb (90 g/m2) bond paper. To reduce paper jams, do not use 
envelopes that:

• Have excessive curl

• Are stuck together

• Are damaged in any way

• Contain windows, holes, perforations, cutouts, or embossing

• Use metal clasps, string ties, or metal folding bars

• Have postage stamps attached

• Have any exposed adhesive when the flap is in the sealed position

• Use card stock with a maximum weight of 163 g/m2 and a minimum size of 3 x 5 in. 
(76.2 x 127 mm).

Media Types and Sizes

Source Media and Size Weight Capacity

Tray 1 Paper, Labels: A4, A5, JIS B5, 
Letter, Legal, Executive, Folio, 
Statement

Transparencies: A4, Letter

16–24 lb
(60–90 g/m2)

250 sheets (20 lb paper)
50 paper labels
50 transparencies

550-Sheet 
Optional Tray

Paper, Labels: A4, A5, JIS B5, 
Letter, Legal, Executive, Folio, 
Statement

Transparencies: A4, Letter

16–24 lb
(60–90 g/m2)

550 sheets (20 lb paper)
50 paper labels
50 transparencies
24 Loading Paper



Manual Feeder Paper, Labels: A4, A5, JIS B5, 
Letter, Legal, Executive, Folio, 
Statement

Transparencies: A4, Letter

Envelopes: Monarch (7 ¾), 9, 
Com-10, C5, B5, DL

Cardstock*

Minimum Feed Size: 3 x 5 in. (76 x 
127 mm)

Maximum Paper Size: 8.5 x 14 in. 
(216 mm x 356 mm)

16–43 lb
(60–163 g/m2)

1 sheet (all media types)

*When printing cardstock using the manual feeder, open the rear exit. For more information, see "Using the Rear 
Exit" on page 23.

Source Media and Size Weight Capacity
Loading Paper 25
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Setting Up for Local Printing
A local printer is a printer attached to one computer using a USB or parallel cable. If your printer 

is attached to a network instead of your computer, go to "Setting Up for Network Printing" on 
page 37. 

A printer driver is software that lets your computer communicate with your printer.

If you purchased your Dell printer and computer together, the printer drivers and utilities 
described in the "Software Overview" on page 41 are automatically installed—you are ready to 
print!

If you purchased your Dell printer separately, use the Drivers and Utilities CD to install all the 
features described in the "Software Overview" on page 41. Use the following table to find the 
instructions you need for your operating system.

You need to complete Microsoft’s Plug and Play before installing the custom driver from your 
printer drivers CD.

For Linux users, refer to the documentation included on the Drivers and Utilities CD for 
installation instructions. To access the documentation, browse to the unix\docs folder on the 
CD.

Computer operating system Go to...

Windows XP Professional x64 page 28

Windows XP page 29

Windows 2003 Server page 30

Windows 2000 page 31

Windows NT page 32

Windows Me page 32

Windows 98 SE page 33

Macintosh OS 9.2 and OS 10.2 page 34
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 Using XP Professional x64 With a USB or Parallel 

Cable
 NOTE: Windows XP Professional requires that you have administrative access to install printer 
drivers on your computer.

When you attached the cable and turned on the printer, the Found New Hardware Wizard 
appeared on your computer screen.

1 Insert the Drivers and Utilities CD into your computer.

The Wizard automatically searches for an appropriate driver.

2 Scroll through the list of drivers until you see 
D:\Drivers\Print\x64\dkaayb40.inf selected in the Location column (where D 
is the drive letter of your CD).

3 Click Next.

The wizard copies all of the necessary files and installs the printer drivers.

4 Click Finish when the software is installed.

5 The Drivers and Utilities CD should launch the installation software automatically.

If the CD does not automatically launch, click Start→Run, type D:\setup.exe (where 
D is the drive letter of your CD), and then click OK.

6 When the Drivers and Utilities CD screen appears, click Personal Installation - Install the 
printer for use on this computer only to install the additional software for your printer.

7 Select your printer from the drop-down box.

8 Select Typical Installation (recommended), and then click Install.

When all of the files are installed on your computer, the Congratulations screen appears.

9 Click Print a Test Page to verify printer setup.

10 Click Finish to exit when the test page prints successfully.
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Using Windows XP With a USB or Parallel Cable
 NOTE: Windows XP Professional requires that you have administrative access to install printer 
drivers on your computer.

When you attached the cable and turned on the printer, the Found New Hardware Wizard 
appeared on your computer screen.

1 Insert the Drivers and Utilities CD into your computer.

The Wizard automatically searches for an appropriate driver.

2 Scroll through the list of drivers until you see 
D:\Drivers\Print\Win_2kXP\dkaay2da.inf selected in the Location column 
(where D is the drive letter of your CD).

3 Click Next.

The wizard copies all of the necessary files and installs the printer drivers.

4 Click Finish when the software is installed.

5 The Drivers and Utilities CD should launch the installation software automatically.

If the CD does not automatically launch, click Start→Run, type D:\setup.exe (where 
D is the drive letter of your CD), and then click OK.

6 When the Drivers and Utilities CD screen appears, click Personal Installation - Install the 
printer for use on this computer only to install the additional software for your printer.

7 Select your printer from the drop-down box.

8 Select Typical Installation (recommended), and then click Install.

When all of the files are installed on your computer, the Congratulations screen appears.

9 Click Print a Test Page to verify printer setup.

10 Click Finish to exit when the test page prints successfully.
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 Using Windows 2003 Server With a USB or 

Parallel Cable
When you attached the cable and turned on the printer, the Found New Hardware Wizard 
appeared on your computer screen.

1 Insert the Drivers and Utilities CD into your computer.

The Wizard automatically searches for an appropriate driver.

2 Scroll through the list of drivers until you see 
D:\Drivers\Print\Win_2kXP\dkaay2da.inf selected in the Location column. 
Instead of D:\ you will see the letter of your CD-ROM drive.

3 Click Next.

The wizard copies all of the necessary files and installs the printer drivers.

4 Click Finish when the software is installed.

5 The Drivers and Utilities CD should launch the installation software automatically.

If the CD does not automatically launch, click Start→ Run, type D:\setup.exe (where 
D is the drive letter of your CD), and then click OK. When the File Download screen 
appears, click Open.

6 When the Drivers and Utilities CD screen appears, click Personal Installation - Install the 
printer for use on this computer only to install the additional software for your printer.

7 Select your printer from the drop-down box.

8 Select Typical Installation (recommended), and then click Install.

When all of the files are installed on your computer, the Congratulations screen appears.

9 Click Print a Test Page to verify printer setup.

10 Click Finish to exit when the test page prints successfully.
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Using Windows 2000 With a USB or Parallel 
Cable
When you attached the cable and turned on the printer, the Found New Hardware Wizard 
appeared on your computer screen.

1 Insert the Drivers and Utilities CD, and then click Next.

2 Select Search for a suitable driver, and then click Next.

3 Select Specify a location only, and then click Next.

4 Browse to the location of the printer driver on the Drivers and Utilities CD: 
D:\Drivers\Print\Win_2kXP\ (where D is the drive letter of your CD).

5 Click Open, and then click OK.

6 Click Next to install the driver that is displayed: 
D:\Drivers\Print\Win_2kXP\dkaay2da.inf.

7 Click Finish when the software is installed.

8 The Drivers and Utilities CD should launch the installation software automatically.

If the CD does not automatically launch, click Start→Run, type D:\setup.exe (where 
D is the drive letter of your CD), and then click OK.

9 When the Drivers and Utilities CD screen appears, click Personal Installation - Install the 
printer for use on this computer only to install the additional software for your printer.

10 Select your printer from the drop-down box.

11 Select Typical Installation (recommended), and then click Install.

When all of the files are installed on your computer, the Congratulations screen appears.

12 Click Print a Test Page to verify printer setup.

13 Click Finish to exit when the test page prints successfully.
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 Using Windows NT With a Parallel Cable

 NOTE: You need administrative access to install printer drivers on your computer.

1 Insert the Drivers and Utilities CD.

2 When the Drivers and Utilities CD screen appears, click Personal Installation - Install the 
printer for use on this computer only to install the additional software for your printer.

3 Select your printer from the drop-down box.

4 Select Typical Installation (recommended), and then click Install.

When all of the files are installed on your computer, the Congratulations screen appears.

5 Click Finish to exit the Drivers and Utilities CD screen.

Using Windows Me With a USB or Parallel Cable
 NOTE: Depending on the software and printers already installed on your computer, your screens may 
vary from those in the instructions.

If you are connecting the printer using a USB cable, you must install both a USB port driver and 
a custom print driver. 

When you attached the cable and turned on the printer and computer, the Add New Hardware 
Wizard screen appeared on your computer screen.

1 Insert the Drivers and Utilities CD.

If you are using a USB cable, the Wizard automatically searches for the USB driver on the 
CD and installs it.

If you are using a parallel cable, skip to step 3.

2 After the USB port driver is found, click Finish.

3 Select Automatic search for the best driver (recommended), and then click Next. 

The wizard searches for a printer driver.

4 Select D:\Drivers\Print\Win_9xMe\<your language folder>\ 
dkaay2da.inf from the list on the screen (where D is the drive letter of your CD), and 
then click OK.

5 Click Next to install the printer driver.

6 Click Next to complete installation.

7 Use the default printer name (for example, Dell Laser Printer 1710) or type a unique name 
for your printer, and then click Next.
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8 Click Yes (recommended), and then click Finish to print a test page. 

9 After the test page prints, click Yes to close the window.

10 Click Finish to complete the installation and close the wizard. 

11 The Drivers and Utilities CD should launch the installation software automatically.

If the CD does not automatically launch, click Start→Run, type D:\setup.exe (where 
D is the drive letter of your CD), and then click OK.

12 When the Drivers and Utilities CD screen appears, click Personal Installation - Install the 
printer for use on this computer only to install the additional software for your printer.

13 Select your printer from the drop-down box.

14 Select Typical Installation (recommended), and then click Install.

When all of the files are installed on your computer, the Congratulations screen appears.

15 Click Finish to exit the Drivers and Utilities CD screen.

Using Windows 98 SE With a USB or Parallel 
Cable

 NOTE: Depending on the software and printers already installed on your computer, your screens may 
vary from those in the instructions.

If you are connecting the printer using a USB cable, you must install both a USB port driver and 
a custom print driver. 

When you attached the cable and turned on the printer, the Found New Hardware Wizard 
appeared on your computer screen.

1 Insert the Drivers and Utilities CD, and then click Next.

2 Select Search for a suitable driver, and then click Next.

3 If you are using a USB cable, select CD-ROM drive only, and then click Next.

If you are using a parallel cable, skip to step 8.

4 After the wizard finds the USB port driver, click Next. 

5 When the USB port driver is installed, click Finish.

The wizard prompts you to search for new drivers.

6 Click Next to search for a printer driver.

7 Select Search for a suitable driver, and then click Next.
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 8 Select Specify a location only, and then click Next.

9 Browse to the location of the printer driver on the Drivers and Utilities CD: 
D:\Drivers\Print\Win_9xMe\<your language folder>\dkaay2da.inf 
(where D is the drive letter of your CD).

10 Highlight the driver, and then select to install the updated driver (recommended).

11 Click Next.

12 Click Next to complete installation.

13 Use the default printer name (for example, Dell Laser Printer 1710) or type a unique name 
for your printer, and then click Next.

14 Select Yes to print a test page, and then click Finish. 

All the necessary files are installed on your computer.

15 After the test page prints, click Yes to close the message window. 

16 Click Finish to complete the installation.

17 The Drivers and Utilities CD should launch the installation software automatically.

If the CD does not automatically launch, click Start → Run, type D:\setup.exe (where 
D is the drive letter of your CD), and then click OK.

18 When the Drivers and Utilities CD screen appears, click Personal Installation - Install the 
printer for use on this computer only to install the additional software for your printer.

19 Select your printer from the drop-down box.

20 Select Typical Installation (recommended), and then click Install.

When all of the files are installed on your computer, the Congratulations screen appears.

21 Click Finish to exit the Drivers and Utilities CD screen.

Using Macintosh OS 9.2 and OS 10.2
The most current drivers for Macintosh are available for download on Dell's website.

1 Go to support.dell.com, and click Small Business.

2 Under Product Support, click Downloads & Drivers.

3 From the Product Model drop-down list, select Printer, and then select 1710n (Network 
Laser).

4 Click the arrow icon.

5 From the Select Your Download Category drop-down list, select Printer Drivers.
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6 From the Select an Operating System drop-down list, select Not Applicable.

7 From the Select an Operating System Language drop-down list, select your language.

8 Click Submit.

9 Under Printer Drivers, select your printer from the list.

10 Under Driver, select your printer driver from the list.

11 Click on the driver filename.

12 Select Download Now Using HTTP or Download Now Using FTP.

13 Click on I agree.

14 Select Save to Disk, and then click OK.

15 Select a location, and then click Save.

16 Browse to the file on your computer, and double-click it to launch the installation software.

17 When the installation software launches, click Continue.

18 Proceed through the software installation screens.
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Setting Up for Network Printing
Print and Check the Network Setup Page

1 When the Ready/Data light  is on solid, press and release Continue  to print a 
menu settings page and a network setup page.

2 Under the Standard Network Card heading on the network setup page, make sure Status is 
Connected.

If Status is Not Connected:

• Make sure the Ethernet cable is firmly plugged into the back of the printer.

• Plug the Ethernet cable into another wall outlet.

3 Under the “TCP/IP” heading on the network setup page, make sure the IP address, 
netmask, and gateway are what you expected.

If you need to change the IP address, run the Set IP Address Utility from the Drivers and 
Utilities CD.

Disable Windows XP Firewall
If your printer is connected directly to a network and the Windows XP firewall is enabled, you 
cannot view your networked printer(s) when you run the printer installation software. To 
prevent this situation, disable the Windows XP firewall before you install the printer software. 
To disable or enable your XP firewall, perform the following steps.

 NOTICE: Dell recommends that you enable your Windows XP firewall after you install the printer 
software. Enabling the Windows XP firewall after you install the printer software does not limit the 
use of your network printer.

1 Click the Start→Help and Support.

2 In the Search box, type firewall, and then click the green arrow.

3 In the Pick a Task list, click Enable or disable Internet Connection Firewall, and then 
follow the instructions on the screen.

After you have disabled the Windows XP firewall, continue with printer installation.
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 Run the Installation Software

1 Insert the Drivers and Utilities CD into your computer.

2 The Drivers and Utilities CD should launch the installation software automatically.

If the CD does not automatically launch, click Start→Run, type D:\setup.exe (where 
D is the drive letter of your CD), and then click OK.

3 When the Drivers and Utilities CD screen appears, click Network Installation - Install the 
printer for use on a network.

4 For local installation, select Install printer on this computer, and then click Next.

For remote installation:

a Select Install printer on one or more remote computers, and then click Next.

b Enter your Administrator user name and password, and then click Add.

c Select the clients or servers, and then click Next.

5 Select the network printer you would like to install. If you do not see your printer listed, 
click Update to refresh the list or click Add Printer to add a printer to the network.

If you are setting up a print server, proceed to step 6. A print server is a computer that 
manages all client print jobs on a network.

If you are setting up a client, skip to step 7. A client is one computer that is directly 
attached to the printer.

6 Select I am setting up this printer on a server, and then click Next.

7 Select your printer from the list. If you would like to change the printer name listed, enter 
a new name in the Printer Name field.

8 If you want other users on the network to access this printer, select Share this printer with 
other computers, and then enter a share name that users will easily identify.

9 Click Next.

10 Select the software and documentation you want to install, and then click Install. For more 
information, see "Software Overview" on page 41.

11 When the Congratulations! screen appears, select whether or not to restart your computer, 
and then click Finish.

Use the Dell Printer Configuration Web Tool, also known as the Printer Embedded Web 
Server, to monitor the status of your network printer without leaving your desk. You can view 
and/or change the printer configuration settings, monitor toner level, and when it is time to 
order replacement toner cartridges, just click the Dell supplies link right from your Web browser.
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 NOTE: The Dell Printer Configuration Web Tool is not available when the printer is locally attached 
to a print server.

To launch the Dell Printer Configuration Web Tool, type the network printer IP address in your 
Web browser, and the printer configuration appears on the screen. Refer to your User’s Guide for 
more information.

You can set up the Dell Printer Configuration Web Tool to send you an email when the printer 
needs supplies or intervention.

To set up email alerts:

1 Launch the Dell Printer Configuration Web Tool.

2 Click Email Alert Setup.

3 Under Setup Email Server, enter the Primary SMTP Gateway and the Reply Address.

4 Under Setup Email Lists and Alerts, enter your email address or the key operator’s email 
address in the email list box.

5 Click Submit.

 For additional network set-up configurations, refer to your User’s Guide.
Setting Up for Network Printing 39



w
w

w
.d

e
ll

.c
o

m
 |

 s
u

p
p

o
rt

.d
e

ll
.c

o
m

40 Setting Up for Network Printing



5

Software Overview
Use the Drivers and Utilities CD that came with your printer to install a combination of 
software applications, depending on your operating system.

 NOTE: If you purchased your printer and computer separately, you must use the Drivers and 
Utilities CD to install these software applications.

 NOTE: These software applications are not available with Linux or Macintosh.

Dell™ Toner Management System
Status Monitor Center

 NOTE: This application is not available with Windows 98 SE or Me, or when the printer is 
connected locally to a computer.

Use the Status Monitor Center to manage multiple Status Monitors.

• Double-click a printer name to open its Status Monitor, or select Run to open a Status 
Monitor for a particular printer.

• Select View to change the appearance of the list of printers.

• Select Help to read the online Help.

Printing Status Window

 NOTE: This application is not available with Windows NT, 98 SE, or Me, or when the printer is 
connected to a network.

The Printing Status window displays the status of the printer (Printer Ready, Printer Offline, 
and Error-Check Printer) and the name of the job when you send a job to print.

The Printing Status window also displays the level of toner so you can:

• Monitor the toner level for your printer.

• Click Order Toner to order replacement toner cartridges.
See "Dell Printer Supplies Reorder Application" on page 42 for more information.
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 Dell Printer Supplies Reorder Application

 NOTE: This application is not available with Windows 98 SE or Me.

The Order Supplies dialog box can be launched from the Printing Status window, the Programs 
window, or the desktop icon.

You can order toner by phone or from the Web.

1 Click Start→Programs or All Programs→Dell Printers→Dell Laser Printer 1710→Dell 
Printer Supplies Reorder Application.
The Order Supplies window appears.

2 If ordering from the Web, click Visit Dell’s cartridge ordering web site.

3 If ordering by phone, call the number that appears under the By Telephone heading.

Dell Local Printer Settings Utility
 NOTE: This application is not available when the printer is connected to a network.

Use the Dell Local Printer Settings Utility to change and save printer settings not available from 
the printer driver. When you change these settings, they remain in effect until you make 
another selection and apply it, or until you restore the original printer settings (called factory 
default settings). The settings are organized by menu, much like a printer operator panel.

The Dell Local Printer Settings Utility is installed automatically on your computer when you 
install the Dell printer driver. Click Start→Programs or All Programs→Dell Printers→Dell Laser 
Printer 1710→Dell Local Printer Settings Utility. The Dell Local Printer Settings Utility only 
functions with printers connected directly to the computer.

For more information, refer to your User’s Guide.

Set IP Address Utility
 NOTE: This application is not available when the printer is connected locally to a computer.

The Set IP Address Utility lets you set up an IP address and other important IP parameters. For 
more information, refer to your User’s Guide.
42 Software Overview



Dell Printer Software Uninstall
Use the Uninstall Software Utility to remove any currently installed printer software or printer 
objects. You can access the Uninstall Software Utility two ways:

• For Windows XP only: Click Start→Control Panel→Printers and Other 
Hardware→Printers and Faxes.

For all others: Click Start→Settings→Printers.

a Select the printer object to uninstall, and then right-click the mouse.

b Select Dell Software Uninstall.

c Select the components to uninstall, and then click Next.

d Click Uninstall Now.

e Click OK when the uninstall is complete.

• Click Start→Programs or All Programs→Dell Printers→Dell Laser Printer 1710.

a Select Dell Printer Software Uninstall.

b Select the components to uninstall, and then click Next.

c Click Uninstall Now.

d Click OK when the uninstall is complete.

Driver Profiler
Use the Driver Profiler to create driver profiles that contain custom driver settings. A driver 
profile can contain a group of saved printer driver settings and other data for things such as:

• Print orientation and N-Up (document settings)

• Installation status of an output tray (printer options)

• User-defined paper sizes (custom papers)

• Simple text and watermarks

• Overlay references

• Font references

• Form associations

For more information, refer to your User’s Guide.
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 Dell Printer Configuration Web Tool

 NOTE: This application is not available when the printer is connected locally to a computer.

The Dell Printer Configuration Web Tool, also known as the Printer Embedded Web Server, lets 
you monitor the status of your network printer without leaving your desk. You can view and/or 
change the printer configuration settings, monitor toner level, and when it is time to order 
replacement toner cartridges, just click the Dell supplies link right from your Web browser.

To launch the Dell Printer Configuration Web Tool, type the network printer IP address in your 
Web browser, and the printer configuration appears on the screen. Refer to your User’s Guide for 
more information.

You can set up the Dell Printer Configuration Web Tool to send you an email when the printer 
needs supplies or intervention.
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To set up email alerts:

1 Launch the Dell Printer Configuration Web Tool.

2 Click Email Alert Setup.

3 Under Setup Email Server, enter the Primary SMTP Gateway and the Reply Address.

4 Under Setup Email Lists and Alerts, enter your email address or the key operator’s email 
address in the email list box.

5 Click Submit.
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6

Printing
Manually Feeding a Print Job
The manual feeder is located at the front of your printer and can only feed one sheet of print 
media at a time.

When using the manual feeder, send the print job to the printer before loading the print media. 
When the printer is ready, it will display the Load Manual Feeder light sequence, at which 
point you should load the media.

To manually feed a print job:

1 From the computer’s software application, select File → Print.

2 Click Properties (or Options, Printer, or Setup, depending on the application) to view the 
printer driver settings.

3 Click the Paper tab.
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 4 Select Manual paper from the Paper tray drop-down list.

5 Select the appropriate Paper size and type.

6 Click OK.

7 Click OK on the Print window to send the job to print.

The printer displays the Load Manual Feeder light sequence.

8 Place a sheet of the selected print media, print side facing up, at the center of the manual 
feeder, but only to the point where its leading edge can contact the paper guides.

• Hold transparencies by the edges and avoid touching the print side. Oil from your 
fingers can affect print quality.

• Insert envelopes with the flap side face down and with the stamp area as shown.

• Load letterhead face up, with the top of the sheet first.

• If you experience problems with paper feed, turn the paper over.

9 Adjust the paper guides to the print media’s width.

10 Hold both sides of the print media close to the manual feeder, and push it into the printer 
until it automatically engages.

There is a brief pause between the time the printer engages the print media and when it 
feeds into the printer.

 NOTICE: Do not force the print media into the feeder. Forcing the media causes jams.
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Printing on Both Sides of the Paper (Manual 
Duplex)
Printing on both sides of the paper reduces printing costs.

Although you can use Tray 1 or the 550-sheet tray to print the first side of the duplex job, only 
use Tray 1 to print the second side.

You can choose how you want your job duplexed: Long Edge or Short Edge.

• Long Edge means pages are bound along the long edge of the page (left edge for portrait, 
top edge for landscape).

• Short Edge means pages are bound along the short edge of the page (top edge for portrait, 
left edge for landscape).
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 To manually duplex a print job:

1 From the computer’s software application, select File → Print.

2 Click Properties (or Options, Printer, or Setup, depending on the application) to view the 
printer driver settings.

3 From the Page Layout tab, select 2-sided printing.

4 Select either Long Edge or Short Edge.

5 Select Manual 2-sided printing.

6 Click the Paper tab.

7 Select the appropriate Input options for your print job.

8 Click OK.

9 Click OK on the Print window.

The printer prints every other page of the document first. Once the first side of your job 

prints, the Load Paper light  comes on, and the Continue  light blinks.

10 Load the paper back into the printer with the already-printed side up and the top of the 
page toward the front of the tray.

Printing Multiple Page Images on One Page 
(N-Up Printing)
The Multipage Printing (N-up) setting is used to print multiple page images on a single page. 
For example, 2-up means two page images are printed on one page, 4-up means four page 
images are printed on one page, and so on.

The printer uses the Multipage Order, Multipage View, and Multipage Border settings to 
determine the order and orientation of the page images, and whether a border is printed around 
each page image.

1 From the computer’s software application, select File → Print.

2 Click Properties (or Options, Printer, or Setup, depending on the application) to view the 
printer driver settings.

3 From the Page Layout tab, select the number of images per sheet (from the Multipage 
printing section) and the orientation you would like the paper to have.

The positioning depends on the number of images and whether the images are portrait or 
landscape in orientation.
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For example, if you select 4-Up multipage printing and portrait orientation, the results 
differ depending on the Multipage Order value you select:

4 To print a visible border around each page image, select Print page borders.

5 Click OK.

6 Click OK on the Print window to send the job to print.

Printing a Booklet
The Booklet setting lets you print multiple pages in booklet form without having to re-format 
your document so the pages print in the proper order. The pages print so that the finished 
collated document may be folded along the center of each page to form a booklet.

If the document contains many pages, a booklet may have too many pages to fold easily. If you 
are printing a fairly large booklet, you might want to use the Sheets per Bundle option to specify 
how many physical pages are put into one bundle. The printer will print the necessary number 
of bundles, which you can then bind into one booklet. Printing in bundles helps the outside 
edge of the pages line up more evenly.
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 You must specify whether or not you want to print using any Duplex printing options before you 

select to print using the booklet function. Once you choose Print Using Booklet, the controls for 
the Duplex options are dimmed and remain at the last setting used.

1 From the computer’s software application, select File → Print.

2 Click Properties (or Options, Printer, or Setup, depending on the application) to view the 
printer driver settings.

3 From the Page Layout tab, click More Page Layout Options.

4 Click Booklet.

5 If your print job is large, you may want to use the Sheets per Bundle option.

6 Select the appropriate binding edge for your print job.

7 To print a visible fold mark on the pages, select Print fold mark.

8 Click OK twice.

9 Click OK on the Print window to send the job to print.

Printing a Poster
The Poster setting lets you print a single image across several pages. Once printed, you can 
combine the pages to create one large image.

1 From the computer’s software application, select File → Print.

2 Click Properties (or Options, Printer, or Setup, depending on the application) to view the 
printer driver settings.
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3 From the Page Layout tab, click More Page Layout Options.

4 Click Poster.

5 Select the poster size you want by choosing the number of pages to use in the poster.

6 To print crop marks on the pages, select Print crop marks.

7 Select the amount of overlap you want each page to have.

8 Click OK twice.

9 Click OK on the Print window to send the job to print.

Printing on Letterhead
To print on letterhead, make sure the paper is loaded with the proper orientation.

1 Make sure the letterhead is properly loaded according to the paper source you are using:

• Tray 1 or 2—Load the letterhead paper with the design side facing down. The top edge 
of the sheet with the logo should be placed at the front of the tray.

• Manual feeder—Load the letterhead paper face-up, with the top of the sheet first.

 NOTE: If you are using the manual feeder, first send the job to print, then load the letterhead when 
the printer displays the Load Manual Feeder light sequence (see "Manually Feeding a Print Job" on 
page 47).

2 From the computer’s software application, select File → Print.

3 Click Properties (or Options, Printer, or Setup, depending on the application) to view the 
printer driver settings.

4 Click the Paper tab.

5 Select Letterhead from the Paper type drop-down lists.

6 Select the appropriate paper size and tray.

7 Click OK.

8 Click OK on the Print window to send the job to print.
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 Canceling a Print Job

A print job can be canceled from the operator panel or from your computer. The Cancel Job 
light sequence is displayed on the operator panel while the job is being cancelled.

From the printer operator panel

Press and release Cancel  to cancel the job currently printing.

From your computer

1 For Windows XP only: Click Start → Control Panel → Printers and Other 
Hardware → Printers and Faxes.

For all others: Click Start → Settings → Printers.

2 Double-click the printer you are using to print the job.

A list of print jobs appears.

3 Right-click the document you want to stop printing, and then click Cancel.
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Maintaining Your Printer
Replacing the Toner Cartridge
You can determine approximately how much toner is left in your cartridge by printing the 
printer settings configuration sheet. This helps you decide when you might need to order 
replacement supplies. For more information on printing the printer settings configuration sheet, 
see "Printing the Printer Settings Configuration Sheet" on page 12.

Also, the Toner low light sequence is displayed when the toner cartridge is nearly empty. You can 
still print for a short time while this sequence is displayed, but print quality begins to decrease as 
the toner level decreases.

When the Toner low light sequence appears or when you experience faded print, remove the 
toner cartridge. Firmly shake it side-to-side and front-to-back several times to redistribute the 
toner, and then reinsert it and continue printing.  Repeat this procedure multiple times until the 
print remains faded. When the print remains faded, replace the toner cartridge.
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 To replace the toner cartridge:

1 Open the front cover by pressing the button on the left side of the printer and lowering the 
cover.

 CAUTION: When replacing a toner cartridge, do not leave the new cartridge exposed 
to direct light for an extended period of time. Extended light exposure can cause 
print quality problems.

2 Press the button on the base of the toner cartridge assembly.
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3 Pull the toner cartridge up and out using the handle.

4 Unpack the new toner cartridge.

5 Rotate the cartridge in all directions to distribute the toner.
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 6 Install the new toner cartridge by aligning the white rollers on the toner cartridge with the 

white arrows on the tracks of the imaging drum and pushing the toner cartridge in as far as 
it will go. The cartridge clicks into place when correctly installed.

7 Close the front cover.
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Replacing the Imaging Drum
You can determine approximately how full the imaging drum is by printing the printer settings 
configuration sheet. This helps you decide when you might need to order replacement supplies. 
For more information on printing the printer settings configuration sheet, see "Printing the 
Printer Settings Configuration Sheet" on page 12.

To ensure print quality and to avoid damage to the printer, the printer stops operating after the 
iamging drum has reached a maximum of 40,000 pages. The printer automatically notifies you 
before the imaging drum reaches this point. For more information, see “Understanding the 
Operator Panel Lights” in your User’s Guide.

When you first receive the Replace imaging drum light sequence you should immediately order 
a new imaging drum. While the printer may continue to function properly after the imaging 
drum has reached its official end-of-life (approximately 30,000 pages), print quality begins to 
significantly decrease until the imaging drum stops operating at the maximum of 40,000 pages.

 NOTICE: When replacing an imaging drum, do not leave the toner cartridge or the new imaging 
drum exposed to direct light for an extended period of time. Extended light exposure can cause print 
quality problems.
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 To replace the imaging drum:

1 Open the front cover by pressing the button on the left side of the printer and lowering the 
cover.

2 Pull the toner cartridge assembly out of the printer by pulling on the toner cartridge 
handle.

Place the toner cartridge assembly on a flat, clean surface.
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3 Press the button on the base of the toner cartridge assembly.

4 Pull the toner cartridge up and out using the handle.

5 Unpack the new imaging drum.

6 Install the toner cartridge into the new toner cartridge assembly by aligning the white 
rollers on the toner cartridge with the white arrows on the tracks of the imaging drum and 
pushing the toner cartridge in as far as it will go. The cartridge clicks into place when 
correctly installed.
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 7 Install the toner cartridge assembly into the printer by aligning the blue arrows on the 

guides of the toner cartridge assembly with the blue arrows on the tracks in the printer and 
pushing the toner cartridge assembly in as far as it will go.

8 After you replace the imaging drum, you should reset the imaging drum’s counter. To reset 

the counter, press and hold the Cancel  button until all lights flash in sequence.

 NOTICE: Resetting the imaging drum's counter without replacing the imaging drum may damage 
your printer and void your warranty.

9 Close the front cover.
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Troubleshooting
Use the following table to find solutions for printing problems you encounter. If you cannot fix 
the problem, contact Dell at support.dell.com. You may have a printer part that requires 
cleaning or replacement by a service technician.

THE PRINT IS GETTING LIGHT, BUT THE TONER LOW /REPLACE DRUM 

 L IGHT IS NOT ON.

Remove the toner cartridge and firmly shake it from side-to-side and front-to-back several to use the 
remaining toner, and then reinsert it and continue printing. Repeat this procedure multiple times until 
the print remains faded.  When the print remains faded, replace the toner cartridge. See “Replacing the 
Toner Cartridge” on page 55 for more information.

THE TONER LOW /REPLACE DRUM  LIGHT IS ON (NOT BLINKING).

Remove the toner cartridge and firmly shake it from side-to-side and front-to-back several to use the 
remaining toner, and then reinsert it and continue printing. Repeat this procedure multiple times until 
the print remains faded. When the print remains faded, replace the toner cartridge. See “Replacing the 
Toner Cartridge” on page 55 for more information.

THE TONER LOW /REPLACE DRUM  LIGHT IS BLINKING.

The imaging drum is approaching full and will need replacing. Immediately order a new imaging drum 
and see “Replacing the Imaging Drum” on page 59 for more information.

THE TONER LOW /REPLACE DRUM  AND THE ERROR  L IGHTS ARE 
BLINKING.

The imaging drum is full and needs replacing. The printer will not print any more pages until the 
imaging drum is replaced. See “Replacing the Imaging Drum” on page 59 for more information.
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THE LOAD PAPER LIGHT  IS ON,  EVEN THOUGH THERE IS PAPER LOADED IN T HE 
250-SHEET OR 550-SHEET TRAY.

Make sure the tray is pushed all the way in.

THE PRINTER IS ON AND THE ERROR LIGHT  IS ON.

Make sure the printer cover is closed.

THE OPERAT OR PANEL LIGHTS DO NOT COME ON WHEN T HE PRINTER IS TURNED ON.
• Wait to see if the lights come on. This may take a few seconds.
• Make sure the power cord is firmly plugged in at the back of the printer and at the electrical outlet.

PAGES ARE BLANK.
• The toner cartridge may be out of toner. Replace the cartridge. See “Replacing the Toner Cartridge” 

on page 55 for more information.
• You may have a software error. Try turning the printer off and back on.

THE PRINTER IS ON,  BUT NOTHING PRINTS

• Make sure the toner cartridge is installed.
• Make sure the parallel, USB, or network cable is firmly plugged into the connector on the back of the 

printer.

• Press and release Continue  to print a menu settings page to determine if the problem is with 
the printer or the computer.

• If you can print a menu settings page, the problem is in the computer or the software program.
• If you cannot print a menu settings page, contact Dell at support.dell.com.

YOU CANNOT CLOSE THE FRONT COVER.

Make sure the toner cartridge is positioned correctly.

THE PRINTER HAS MISSING OR DAMAGED PARTS.

Contact Dell at support.dell.com.
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PAPER IS  JAMMED IN THE PRINTER.

When a paper jam occurs, the printer stops and the operator panel’s Paper Jam  and Continue  

lights come on. Press and release Continue  twice quickly to display the specific secondary error 
paper jam light sequence. Refer to your User’s Guide for more information.

We recommend that you clear the entire paper path when a paper jam occurs.

To clear a paper jam:
1 If you are feeding paper from a tray, remove the tray, and then remove any jams.
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2 Open the front cover and remove the toner cartridge assembly.

NOTE: Do not leave the toner cartridge assembly exposed to direct light for an extended period of time. 
Extended light exposure can cause print quality problems.
3 Remove any jams in the area behind the toner cartridge assembly.
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For information on operator panel lights or solving print quality problems, refer to your User’s 
Guide.

4 Lift the flap at the front of the printer and remove any jams beneath the flap.

 5 Open the rear exit and remove any jams.

6 After you have cleared the jams, reinstall the toner cartridge assembly, make sure all printer covers 

and trays are closed, and then press Continue  to resume printing.
NOTE: The printer reprints the pages that caused the paper jam.
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Contacting Dell
Technical Assistance
If you need help with a technical problem, Dell is ready to assist you.

1 Call technical support from a telephone near or at the printer so that technical support can 
assist you with any necessary procedures. When calling Dell, use your Express Service 
Code to help expedite the routing of your call to the proper support personnel.

The Express Service Code is located on the back panel of the printer near the serial 
number for the printer.

NOTE: Dell's Express Service Code system may not be available in all countries.

2 In the U.S., Business customers should call 1-877-459-7298, and Consumer (Home and 
Home Office) customers should call 1-800-624-9896.

If you are calling from a different country or are in a different Service area, see "Contacting 
Dell" on page 70 for your local telephone number.

3 Follow the menu prompts in the automated telephone system to speak with a technical 
support representative.

Automated Order-Status Service
To check on the status of any Dell products that you have ordered, you can go to 
support.dell.com, or you can call the automated order-status service. A recording prompts you 
for the information needed to locate and report on your order. See "Contacting Dell" on page 70 
for the telephone number to call for your region.
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 Contacting Dell

To contact Dell electronically, you can access the following websites:

• www.dell.com

• support.dell.com (technical support)

• premiersupport.dell.com (technical support for educational, government, healthcare, and 
medium/large business customers, including Premier, Platinum, and Gold customers)

For specific web addresses for your country, find the appropriate country section in the table 
below. 

NOTE: Toll-free numbers are for use within the country for which they are listed.

When you need to contact Dell, use the electronic addresses, telephone numbers, and codes 
provided in the following table. If you need assistance in determining which codes to use, 
contact a local or an international operator.
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Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers

Anguilla General Support toll-free: 800-335-0031

Antigua and Barbuda General Support 1-800-805-5924

Argentina (Buenos Aires)

International Access Code: 00

Country Code: 54

City Code: 11

Website: www.dell.com.ar

E-mail: us_latin_services@dell.com

E-mail for desktop and portable computers: 
la-techsupport@dell.com 

E-mail for servers and EMC:
la_enterprise@dell.com

Customer Care  toll-free: 0-800-444-0730

Tech Support toll-free: 0-800-444-0733

Tech Support Services toll-free: 0-800-444-0724

Sales 0-810-444-3355

Aruba General Support toll-free: 800-1578

Australia (Sydney)

International Access Code: 0011

Country Code: 61

City Code: 2

E-mail (Australia): au_tech_support@dell.com

E-mail (New Zealand): nz_tech_support@dell.com

Home and Small Business 1-300-655-533

Government and Business toll-free: 1-800-633-559

Preferred Accounts Division (PAD) toll-free: 1-800-060-889

Customer Care toll-free: 1-800-819-339

Technical Support (portables and desktops) toll-free: 1-300-655-533

Technical Support (servers and workstations) toll-free: 1-800-733-314

Corporate Sales toll-free: 1-800-808-385

Transaction Sales toll-free: 1-800-808-312

Fax toll-free: 1-800-818-341
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Austria (Vienna)

International Access Code: 900

Country Code: 43

City Code: 1

Website: support.euro.dell.com

E-mail: tech_support_central_europe@dell.com

Home/Small Business Sales 0820 240 530 00

Home/Small Business Fax 0820 240 530 49

Home/Small Business Customer Care 0820 240 530 14

Preferred Accounts/Corporate Customer Care 0820 240 530 16

Home/Small Business Technical Support 0820 240 530 14

Preferred Accounts/Corporate Technical Support 0660 8779

Switchboard 0820 240 530 00

Bahamas General Support toll-free: 1-866-278-6818

Barbados General Support 1-800-534-3066

Belgium (Brussels)

International Access Code: 00

Country Code: 32

City Code: 2

Website: support.euro.dell.com

E-mail for French-speaking Customers: 
support.euro.dell.com/be/fr/emaildell/

Technical Support 02 481 92 88

Technical Support Fax 02 481 92 95

Customer Care 02 713 15 65

Corporate Sales 02 481 91 00

Fax 02 481 92 99

Switchboard 02 481 91 00

Bermuda General Support 1-800-342-0671

Bolivia General Support toll-free: 800-10-0238

Brazil

International Access Code: 00

Country Code: 55

City Code: 51

Website: www.dell.com/br

Customer Support, Technical Support 0800 90 3355

Technical Support Fax  51 481 5470

Customer Care Fax  51 481 5480

Sales 0800 90 3390

British Virgin Islands General Support toll-free: 1-866-278-6820

Brunei

Country Code: 673

Customer Technical Support (Penang, Malaysia) 604 633 4966

Customer Service (Penang, Malaysia) 604 633 4949

Sales (Singapore) toll-free: 1 800 394 7425

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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Canada (North York, Ontario)

International Access Code: 011

Online Order Status: www.dell.ca/ostatus

AutoTech (automated technical support) toll-free: 1-800-247-9362

Customer Care (Home Sales/Small Business) toll-free: 1-800-847-4096

Customer Care (med./large business, government) toll-free: 1-800-326-9463

Technical Support (Home Sales/Small Business) toll-free: 1-800-847-4096

Technical Support (med./large bus., government) toll-free: 1-800-387-5757

Sales (Home Sales/Small Business) toll-free: 1-800-387-5752

Sales (med./large bus., government) toll-free: 1-800-387-5755

Spare Parts Sales & Extended Service Sales 1 866 440 3355

Cayman Islands General Support 1-800-805-7541

Chile (Santiago)

Country Code: 56

City Code: 2

Sales, Customer Support, and Technical Support toll-free: 1230-020-4823

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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China (Xiamen)

Country Code: 86

City Code: 592

Technical Support website: support.dell.com.cn

Technical Support E-mail: cn_support@dell.com

Customer Care E-mail: customer_cn@dell.com

Technical Support Fax 592 818 1350

Technical Support (Dell™ Dimension™ and 
Inspiron™)

toll-free: 800 858 2969

Technical Support (OptiPlex™, Latitude™, and 
Dell Precision™)

toll-free: 800 858 0950

Technical Support (servers and storage) toll-free: 800 858 0960

Technical Support (projectors, PDAs, switches, 
routers, and so on)

toll-free: 800 858 2920

Technical Support (printers) 86 592 818 3144
or toll-free: 800 858 2311

Customer Care toll-free: 800 858 2060

Customer Care Fax 592 818 1308

Home and Small Business toll-free: 800 858 2222

Preferred Accounts Division toll-free: 800 858 2557

Large Corporate Accounts GCP toll-free: 800 858 2055

Large Corporate Accounts Key Accounts toll-free: 800 858 2628

Large Corporate Accounts North toll-free: 800 858 2999

Large Corporate Accounts North Government and 
Education

toll-free: 800 858 2955

Large Corporate Accounts East toll-free: 800 858 2020

Large Corporate Accounts East Government and 
Education

toll-free: 800 858 2669

Large Corporate Accounts Queue Team toll-free: 800 858 2572

Large Corporate Accounts South toll-free: 800 858 2355

Large Corporate Accounts West toll-free: 800 858 2811

Large Corporate Accounts Spare Parts toll-free: 800 858 2621

Colombia General Support 980-9-15-3978

Costa Rica General Support 0800-012-0435

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
74 Contacting Dell



Czech Republic (Prague)

International Access Code: 00

Country Code: 420

Website: support.euro.dell.com

E-mail: czech_dell@dell.com

Technical Support 22537 2727

Customer Care 22537 2707

Fax 22537 2714

Tech Fax 22537 2728

Switchboard 22537 2711

Denmark (Copenhagen)

International Access Code: 00

Country Code: 45 

Website: support.euro.dell.com

E-mail: support.euro.dell.com/dk/da/emaildell/

Technical Support 7023 0182

Customer Care (Relational) 7023 0184

Home/Small Business Customer Care 3287 5505

Switchboard (Relational) 3287 1200

Switchboard Fax (Relational) 3287 1201

Switchboard (Home/Small Business) 3287 5000

Switchboard Fax (Home/Small Business) 3287 5001

Dominica General Support toll-free: 1-866-278-6821

Dominican Republic General Support 1-800-148-0530

Ecuador General Support toll-free: 999-119

El Salvador General Support 01-899-753-0777

Finland (Helsinki)

International Access Code: 990

Country Code: 358

City Code: 9

Website: support.euro.dell.com

E-mail: support.euro.dell.com/fi/fi/emaildell/

Technical Support 09 253 313 60

Customer Care 09 253 313 38

Fax 09 253 313 99

Switchboard 09 253 313 00

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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France (Paris) (Montpellier)

International Access Code: 00

Country Code: 33

City Codes: (1) (4)

Website: support.euro.dell.com

E-mail: support.euro.dell.com/fr/fr/emaildell/

Home and Small Business

Technical Support 0825 387 270

Customer Care 0825 823 833

Switchboard 0825 004 700

Switchboard (calls from outside of France) 04 99 75 40 00

Sales 0825 004 700

Fax 0825 004 701

Fax (calls from outside of France) 04 99 75 40 01

Corporate

Technical Support 0825 004 719

Customer Care 0825 338 339

Switchboard 01 55 94 71 00

Sales 01 55 94 71 00

Fax 01 55 94 71 01

Germany (Langen)

International Access Code: 00

Country Code: 49

City Code: 6103

Website: support.euro.dell.com

E-mail: tech_support_central_europe@dell.com

Technical Support 06103 766-7200

Home/Small Business Customer Care 0180-5-224400

Global Segment Customer Care 06103 766-9570

Preferred Accounts Customer Care 06103 766-9420

Large Accounts Customer Care 06103 766-9560

Public Accounts Customer Care 06103 766-9555

Switchboard 06103 766-7000

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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Greece

International Access Code: 00

Country Code: 30

Website: support.euro.dell.com

E-mail: support.euro.dell.com/gr/en/emaildell/

Technical Support 00800-44 14 95 18

Gold Service Technical Support 00800-44 14 00 83

Switchboard 2108129810

Gold Service Switchboard 2108129811

Sales 2108129800

Fax 2108129812

Grenada General Support toll-free: 1-866-540-3355

Guatemala General Support 1-800-999-0136

Guyana General Support toll-free: 1-877-270-4609

Hong Kong

International Access Code: 001

Country Code: 852

Website: support.ap.dell.com

Technical Support E-mail: apsupport@dell.com

Technical Support (Dimension and Inspiron) 2969 3188

Technical Support (OptiPlex, Latitude, and Dell 
Precision)

2969 3191

Technical Support (PowerApp™, PowerEdge™, 
PowerConnect™, and PowerVault™)

2969 3196

Customer Care 3416 0910

Large Corporate Accounts 3416 0907

Global Customer Programs 3416 0908

Medium Business Division 3416 0912

Home and Small Business Division 2969 3105

India Technical Support 1600 33 8045

Sales (Large Corporate Accounts) 1600 33 8044

Sales (Home and Small Business) 1600 33 8046

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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Ireland (Cherrywood)

International Access Code: 16

Country Code: 353

City Code: 1

Website: support.euro.dell.com

E-mail: dell_direct_support@dell.com

Technical Support 1850 543 543

U.K. Technical Support (dial within U.K. only) 0870 908 0800

Home User Customer Care 01 204 4014

Small Business Customer Care 01 204 4014

U.K. Customer Care (dial within U.K. only) 0870 906 0010

Corporate Customer Care 1850 200 982

Corporate Customer Care (dial within U.K. only) 0870 907 4499

Ireland Sales 01 204 4444

U.K. Sales (dial within U.K. only) 0870 907 4000

Fax/Sales Fax 01 204 0103

Switchboard 01 204 4444

Italy (Milan)

International Access Code: 00

Country Code: 39

City Code: 02

Website: support.euro.dell.com

E-mail: support.euro.dell.com/it/it/emaildell/

Home and Small Business

Technical Support 02 577 826 90

Customer Care 02 696 821 14

Fax 02 696 821 13

Switchboard 02 696 821 12

Corporate

Technical Support 02 577 826 90

Customer Care 02 577 825 55

Fax 02 575 035 30

Switchboard 02 577 821

Jamaica General Support (dial from within Jamaica only) 1-800-682-3639

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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Japan (Kawasaki)

International Access Code: 001

Country Code: 81

City Code: 44

Website: support.jp.dell.com

Technical Support (servers) toll-free: 0120-198-498

Technical Support outside of Japan (servers) 81-44-556-4162

Technical Support (Dimension and Inspiron) toll-free: 0120-198-226

Technical Support outside of Japan (Dimension and 
Inspiron)

81-44-520-1435

Technical Support (Dell Precision, OptiPlex, and 
Latitude)

toll-free: 0120-198-433

Technical Support outside of Japan (Dell Precision, 
OptiPlex, and Latitude)

81-44-556-3894

Technical Support (PDAs, projectors, printers, 
routers)

toll-free: 0120-981-690

Technical Support outside of Japan (PDAs, 
projectors, printers, routers)

81-44-556-3468

Faxbox Service 044-556-3490

24-Hour Automated Order Service 044-556-3801

Customer Care 044-556-4240

Business Sales Division (up to 400 employees) 044-556-1465

Preferred Accounts Division Sales (over 400 
employees)

044-556-3433

Large Corporate Accounts Sales (over 3500 
employees)

044-556-3430

Public Sales (government agencies, educational 
institutions, and medical institutions)

044-556-1469

Global Segment Japan 044-556-3469

Individual User 044-556-1760

Switchboard 044-556-4300

Korea (Seoul)

International Access Code: 001

Country Code: 82

City Code: 2

Technical Support toll-free: 080-200-3800

Sales toll-free: 080-200-3600

Customer Service (Penang, Malaysia) 604 633 4949

Fax 2194-6202

Switchboard 2194-6000

Technical Support (Electronics and Accessories) toll-free: 080-200-3801

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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Latin America Customer Technical Support (Austin, Texas, 
U.S.A.)

512 728-4093

Customer Service (Austin, Texas, U.S.A.) 512 728-3619

Fax (Technical Support and Customer Service) 
(Austin, Texas, U.S.A.)

512 728-3883

Sales (Austin, Texas, U.S.A.) 512 728-4397

SalesFax (Austin, Texas, U.S.A.) 512 728-4600

or 512 728-3772

Luxembourg

International Access Code: 00

Country Code: 352

Website: support.euro.dell.com

E-mail: tech_be@dell.com

Technical Support (Brussels, Belgium) 3420808075

Home/Small Business Sales (Brussels, Belgium) toll-free: 080016884

Corporate Sales (Brussels, Belgium) 02 481 91 00

Customer Care (Brussels, Belgium) 02 481 91 19

Fax (Brussels, Belgium) 02 481 92 99

Switchboard (Brussels, Belgium) 02 481 91 00

Macao

Country Code: 853

Technical Support toll-free: 0800 105

Customer Service (Xiamen, China) 34 160 910

Transaction Sales (Xiamen, China) 29 693 115

Malaysia (Penang)

International Access Code: 00

Country Code: 60

City Code: 4

Website: support.ap.dell.com

Technical Support (Dell Precision, OptiPlex, and 
Latitude)

toll-free: 1 800 88 0193

Technical Support (Dimension, Inspiron, and 
Electronics and Accessories)

toll-free: 1 800 88 1306

Technical Support (PowerApp, PowerEdge, 
PowerConnect, and PowerVault) 

toll-free: 1800 88 1386

Customer Service (Penang, Malaysia) 04 633 4949

Sales toll-free: 1 800 88 0553

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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Mexico

International Access Code: 00

Country Code: 52

Customer Technical Support 001-877-384-8979

or 001-877-269-3383

Sales 50-81-8800

or 01-800-888-3355

Customer Service 001-877-384-8979

or 001-877-269-3383

Main 50-81-8800

or 01-800-888-3355

Montserrat General Support toll-free: 1-866-278-6822

Netherlands Antilles General Support 001-800-882-1519

Netherlands (Amsterdam)

International Access Code: 00

Country Code: 31

City Code: 20

Website: support.euro.dell.com

Technical Support 020 674 45 00

Technical Support Fax 020 674 47 66

Home/Small Business Customer Care 020 674 42 00

Relational Customer Care  020 674 43 25

Home/Small Business Sales 020 674 55 00

Relational Sales 020 674 50 00

Home/Small Business Sales Fax 020 674 47 75

Relational Sales Fax 020 674 47 50

Switchboard 020 674 50 00

Switchboard Fax 020 674 47 50

New Zealand

International Access Code: 00

Country Code: 64

E-mail (New Zealand): nz_tech_support@dell.com

E-mail (Australia): au_tech_support@dell.com

Technical Support (for desktop and portable 
computers) 

toll-free: 0800 446 255

Technical Support (for servers and workstations) toll-free: 0800 443 563

Home and Small Business 0800 446 255

Government and Business 0800 444 617

Sales 0800 441 567

Fax 0800 441 566

Nicaragua General Support 001-800-220-1006

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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Norway (Lysaker)

International Access Code: 00

Country Code: 47

Website: support.euro.dell.com

E-mail: support.euro.dell.com/no/no/emaildell/

Technical Support 671 16882

Relational Customer Care 671 17575

Home/Small Business Customer Care 231 62298

Switchboard 671 16800

Fax Switchboard 671 16865

Panama General Support 001-800-507-0962

Peru General Support 0800-50-669

Poland (Warsaw)

International Access Code: 011

Country Code: 48

City Code: 22

Website: support.euro.dell.com

E-mail: pl_support_tech@dell.com

Customer Service Phone 57 95 700

Customer Care 57 95 999

Sales 57 95 999

Customer Service Fax 57 95 806

Reception Desk Fax 57 95 998

Switchboard 57 95 999

Portugal

International Access Code: 00

Country Code: 351

Website: support.euro.dell.com

E-mail: support.euro.dell.com/pt/en/emaildell/

Technical Support 707200149

Customer Care 800 300 413

Sales 800 300 410, 800 300 411,
800 300 412, or 21 422 07 10

Fax 21 424 01 12

Puerto Rico General Support 1-800-805-7545

St. Kitts and Nevis General Support toll-free: 1-877-441-4731

St. Lucia General Support 1-800-882-1521

St. Vincent and the Grenadines General Support toll-free: 1-877-270-4609

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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Singapore (Singapore)

International Access Code: 005

Country Code: 65

Website: support.ap.dell.com

Technical Support (Dimension, Inspiron, and 
Electronics and Accessories)

toll-free: 1800 394 7430

Technical Support (OptiPlex, Latitude, and Dell 
Precision)

toll-free: 1800 394 7488

Technical Support (PowerApp, PowerEdge, 
PowerConnect, and PowerVault)

toll-free: 1800 394 7478

Customer Service (Penang, Malaysia) 604 633 4949

Sales toll-free: 1 800 394 7425

Slovakia (Prague)

International Access Code: 00

Country Code: 421

Website: support.euro.dell.com

E-mail: czech_dell@dell.com

Technical Support 02 5441 5727

Customer Care 420 22537 2707

Fax 02 5441 8328

Tech Fax 02 5441 8328

Switchboard (Sales) 02 5441 7585

South Africa (Johannesburg)

International Access Code:

09/091

Country Code: 27

City Code: 11

Website: support.euro.dell.com

E-mail: dell_za_support@dell.com

Gold Queue 011 709 7713

Technical Support 011 709 7710

Customer Care 011 709 7707

Sales 011 709 7700

Fax 011 706 0495

Switchboard 011 709 7700

Southeast Asian and Pacific 
Countries

Customer Technical Support, Customer Service, 
and Sales (Penang, Malaysia)

604 633 4810

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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Spain (Madrid)

International Access Code: 00

Country Code: 34

City Code: 91

Website: support.euro.dell.com

E-mail: support.euro.dell.com/es/es/emaildell/

Home and Small Business

Technical Support 902 100 130

Customer Care 902 118 540

Sales 902 118 541

Switchboard 902 118 541

Fax 902 118 539

Corporate

Technical Support 902 100 130

Customer Care 902 115 236

Switchboard 91 722 92 00

Fax 91 722 95 83

Sweden (Upplands Vasby)

International Access Code: 00

Country Code: 46

City Code: 8

Website: support.euro.dell.com

E-mail: support.euro.dell.com/se/sv/emaildell/

Technical Support 08 590 05 199

Relational Customer Care 08 590 05 642

Home/Small Business Customer Care 08 587 70 527

Employee Purchase Program (EPP) Support 20 140 14 44

Technical Support Fax 08 590 05 594

Sales 08 590 05 185

Switzerland (Geneva)

International Access Code: 00

Country Code: 41

City Code: 22

Website: support.euro.dell.com

E-mail: Tech_support_central_Europe@dell.com

E-mail for French-speaking HSB and Corporate 
Customers: support.euro.dell.com/ch/fr/emaildell/

Technical Support (Home and Small Business) 0844 811 411

Technical Support (Corporate) 0844 822 844

Customer Care (Home and Small Business) 0848 802 202

Customer Care (Corporate) 0848 821 721

Fax 022 799 01 90

Switchboard 022 799 01 01

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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Taiwan

International Access Code: 002

Country Code: 886

Website: support.ap.dell.com

E-mail: ap_support@dell.com

Technical Support (OptiPlex, Latitude, Inspiron, 
Dimension, and Electronics and Accessories)

toll-free: 00801 86 1011

Technical Support (PowerApp, PowerEdge, 
PowerConnect, and PowerVault)

toll-free: 00801 60 1256

Transaction Sales toll-free: 00801 65 1228

Corporate Sales toll-free: 00801 65 1227

Thailand

International Access Code: 001

Country Code: 66

Website: support.ap.dell.com

Technical Support (OptiPlex, Latitude, and Dell 
Precision)

toll-free: 1800 0060 07

Technical Support (PowerApp, PowerEdge, 
PowerConnect, and PowerVault)

toll-free: 1800 0600 09

Customer Service (Penang, Malaysia) 604 633 4949

Corporate Sales toll-free: 1800 006 009

Transaction Sales toll-free: 1800 006 006

Trinidad/Tobago General Support 1-800-805-8035

Turks and Caicos Islands General Support toll-free: 1-866-540-3355

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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U.K. (Bracknell)

International Access Code: 00

Country Code: 44

City Code: 1344

Website: support.euro.dell.com

Customer Care website: support.euro.dell.com/uk/en/ECare/Form/Home.asp

E-mail: dell_direct_support@dell.com

Technical Support (Corporate/Preferred 
Accounts/PAD [1000+ employees])

0870 908 0500

Technical Support (direct and general) 0870 908 0800

Global Accounts Customer Care 01344 373 186

Home and Small Business Customer Care 0870 906 0010

Corporate Customer Care 01344 373 185

Preferred Accounts (500–5000 employees) 
Customer Care

0870 906 0010

Central Government Customer Care 01344 373 193

Local Government & Education Customer Care 01344 373 199

Health Customer Care 01344 373 194

Home and Small Business Sales 0870 907 4000

Corporate/Public Sector Sales 01344 860 456

Home and Small Business Fax 0870 907 4006

Uruguay General Support toll-free: 000-413-598-2521

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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U.S.A. (Austin, Texas)

International Access Code: 011

Country Code: 1

Automated Order-Status Service toll-free: 1-800-433-9014

AutoTech (portable and desktop computers) toll-free: 1-800-247-9362

Consumer (Home and Home Office) 

Technical Support toll-free: 1-800-624-9896

Customer Service toll-free: 1-800-624-9897

DellNet™ Service and Support toll-free: 1-877-Dellnet

(1-877-335-5638)

Employee Purchase Program (EPP) Customers toll-free: 1-800-695-8133

Financial Services website: www.dellfinancialservices.com

Financial Services (lease/loans) toll-free: 1-877-577-3355

Financial Services (Dell Preferred Accounts [DPA]) toll-free: 1-800-283-2210

Business 

Customer Service and Technical Support toll-free: 1-800-822-8965

Employee Purchase Program (EPP) Customers toll-free: 1-800-695-8133

Printers and Projectors Technical Support toll-free: 1-877-459-7298

Public (government, education, and healthcare)

Customer Service and Technical Support toll-free: 1-800-456-3355

Employee Purchase Program (EPP) Customers toll-free: 1-800-234-1490

Dell Sales toll-free: 1-800-289-3355

 or toll-free: 1-800-879-3355

Dell Outlet Store (Dell refurbished computers) toll-free: 1-888-798-7561

Software and Peripherals Sales toll-free: 1-800-671-3355

Spare Parts Sales toll-free: 1-800-357-3355

Extended Service and Warranty Sales toll-free: 1-800-247-4618

Fax toll-free: 1-800-727-8320

Dell Services for the Deaf, Hard-of-Hearing, or 
Speech-Impaired

toll-free: 1-877-DELLTTY

(1-877-335-5889)

U.S. Virgin Islands General Support 1-877-673-3355

Venezuela General Support 8001-3605

Country (City)
International Access Code 
Country Code
City Code

Department Name or Service Area,
Website and E-Mail Address

Area Codes,
Local Numbers, and

Toll-Free Numbers
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Appendix
U.S. Terms and Conditions of Sale 
These terms and conditions ("Agreement") apply to your purchase of computer systems and/or related products and/or 
services and support sold in the United States ("Product") by the Dell entity named on the invoice or acknowledgement 
("Dell") provided to you. By accepting delivery of the Product, you accept and are bound to the terms and conditions of 
this Agreement. If you do not wish to be bound by this Agreement, you must notify Dell immediately and return your 
purchase pursuant to Dell's Total Satisfaction Return Policy. 
(See: http://support.dell.com/ContactUs/ByPhone.aspx?c=us&l=en&s=gen for our contact information.) If returned, 
Product(s) must remain in the boxes in which they were shipped. THIS AGREEMENT SHALL APPLY UNLESS (I) 
YOU HAVE A SEPARATE PURCHASE AGREEMENT WITH DELL, IN WHICH CASE THE SEPARATE 
AGREEMENT SHALL GOVERN; OR (II) OTHER DELL TERMS AND CONDITIONS APPLY TO THE 
TRANSACTION.

1 Other Documents. 

This Agreement may NOT be altered, supplemented, or amended by the use of any other document(s) unless 
otherwise agreed to in a written agreement signed by both you and Dell. If you do not receive an invoice or 
acknowledgement in the mail, via e-mail, or with your Product, information about your purchase may be obtained at 
http://support.dell.com/dellcare/Invoice.aspx or by contacting your sales representative.

2 Payment Terms; Orders; Quotes; Interest. 

Payment terms are within Dell's sole discretion, and, unless otherwise agreed to by Dell, payment must be made at 
the time of purchase. Payment for Product may be made by credit card, wire transfer, or some other prearranged 
payment method. Dell may invoice parts of an order separately. Your order is subject to cancellation by Dell, at Dell's 
sole discretion. Unless you and Dell have agreed to a different discount, Dell's standard pricing policy for 
Dell™-branded systems, which include both hardware and services in one discounted price, allocates the discount off 
list price applicable to the service portion of the system to be equal to the overall calculated percentage discount off 
list price on the entire system. Dell is not responsible for pricing, typographical, or other errors, in any offer by Dell 
and reserves the right to cancel any orders resulting from such errors.

3 Shipping Charges; Taxes; Title; Risk of Loss. 

Shipping and handling are additional unless otherwise expressly indicated at the time of sale. Loss or damage that 
occurs during shipping by a carrier selected by Dell is Dell's responsibility. Loss or damage that occurs during 
shipping by a carrier selected by you is your responsibility. You must notify Dell within 30 days of the date of your 
invoice or acknowledgement if you believe any part of your purchase is missing, wrong or damaged. Unless you 
provide Dell with a valid and correct tax exemption certificate applicable to your purchase of Product and the 
Product ship-to location, you are responsible for sales and other taxes associated with the order. Shipping dates are 
estimates only. Title to software will remain with the applicable licensor(s).

4 Warranties. 

THE LIMITED WARRANTIES APPLICABLE TO DELL-BRANDED HARDWARE PRODUCT CAN BE FOUND 
AT http://www.dell.com/policy/legal/warranty.htm OR IN THE DOCUMENTATION DELL PROVIDES WITH 
THE PRODUCT. DELL MAKES NO WARRANTIES FOR SERVICE, SOFTWARE, OR NON-DELL BRANDED 
PRODUCT. SUCH PRODUCT IS PROVIDED BY DELL "AS IS." WARRANTY AND SERVICE FOR NON-DELL 
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 BRANDED PRODUCT, IF ANY, IS PROVIDED BY THE ORIGINAL MANUFACTURER, NOT BY DELL. DELL 

MAKES NO EXPRESS WARRANTIES EXCEPT THOSE STATED IN DELL'S APPLICABLE WARRANTY 
STATEMENT IN EFFECT ON THE DATE OF THE INVOICE, PACKING SLIP OR ACKNOWLEDGEMENT. 
WARRANTIES AND SERVICE WILL BE EFFECTIVE, AND DELL WILL BE OBLIGATED TO HONOR ANY 
SUCH WARRANTIES AND SERVICES, ONLY UPON DELL'S RECEIPT OF PAYMENT IN FULL FOR THE 
ITEM TO BE WARRANTED OR SERVICED. 

5 Software. 

All software is provided subject to the license agreement that is part of the software package and you agree that you 
will be bound by such license agreement.

6 Return Policies; Exchanges. 

New and refurbished Product that you purchase directly from Dell (and not a third party) you may return or exchange 
only in accordance with Dell's return policy in effect on the date of the invoice or acknowledgement. Any returns or 
exchanges will be made in accordance with Dell's exchange policies in effect on the date of the return or exchange. 
You must contact us directly before you attempt to return Product to obtain a Return Material Authorization 
Number for you to include with your return. You must return Product to us in their original or equivalent packaging. 
You are responsible for risk of loss, shipping and handling fees for returning or exchanging Product. Additional fees 
may apply. Dell's return policy for Dell-branded Product can be found at: 
http://www.dell.com/policy/legal/warranty.htm. Non-Dell branded software and peripheral return policies can be 
found at: http://rcommerce.us.dell.com/rcomm/include/dw_policies.htm. 

Refurbished Product return policies can be found at: 
http://www.dell.com/us/en/dfh/topics/segtopic_nav_info_002_info.htm. If you fail to follow the return or exchange 
instructions and policies provided by Dell, Dell is not responsible whatsoever for Product that is lost, damaged, 
modified or otherwise processed for disposal or resale. If you are returning all components in an order, you will be 
credited the full amount paid for the order. At Dell's discretion, credit for partial returns may be less than invoice or 
individual component prices due to bundled or promotional pricing.

7 Changed or Discontinued Product.

Dell's policy is one of ongoing update and revision. Dell may revise and discontinue Product at any time without 
notice to you and this may affect information saved in your online "cart." Dell will ship Product that has the 
functionality and performance of the Product ordered, but changes between what is shipped and what is described in 
a specification sheet or catalog are possible. Parts used in repairing or servicing Product may be new, 
equivalent-to-new, or reconditioned. 

8 Service and Support. 

Service offerings may vary from Product to Product. If you purchase optional services and support from Dell, Dell 
and/or your third-party service provider will provide such service and support to you in the United States in 
accordance with the terms and conditions located at 
http://www.dell.com/us/en/gen/services/service_service_contracts.htm or as mailed to you. You may contact Dell for 
more information, see http://www1.us.dell.com/content/topics/segtopic.aspx/contact/contact?c=us&l=en&s=gen 
for contact information. Dell and/or the third-party service provider may at their discretion, revise their general and 
optional service and support programs and the terms and conditions that govern them without prior notice to you. 
Dell has no obligation to provide service or support until Dell has received full payment for the Product or 
service/support contract you purchased. Dell is not obligated to provide service or support you purchase through a 
third party and not Dell.

9 Limitation of Liability. 

DELL DOES NOT ACCEPT LIABILITY BEYOND THE REMEDIES SET FORTH HEREIN, INCLUDING BUT 
NOT LIMITED TO ANY LIABILITY FOR PRODUCT NOT BEING AVAILABLE FOR USE, LOST PROFITS, 
LOSS OF BUSINESS OR FOR LOST OR CORRUPTED DATA OR SOFTWARE, OR THE PROVISION OF 
SERVICES AND SUPPORT. EXCEPT AS EXPRESSLY PROVIDED HEREIN, DELL WILL NOT BE LIABLE 
FOR ANY CONSEQUENTIAL, SPECIAL, INDIRECT, OR PUNITIVE DAMAGES, EVEN IF ADVISED OF THE 
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POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY THIRD PARTY. YOU AGREE THAT FOR 
ANY LIABILITY RELATED TO THE PURCHASE OF PRODUCT, DELL IS NOT LIABLE OR RESPONSIBLE 
FOR ANY AMOUNT OF DAMAGES ABOVE THE AMOUNT INVOICED FOR THE APPLICABLE PRODUCT. 
NOTWITHSTANDING ANYTHING IN THIS AGREEMENT TO THE CONTRARY, THE REMEDIES SET 
FORTH IN THIS AGREEMENT SHALL APPLY EVEN IF SUCH REMEDIES FAIL THEIR ESSENTIAL 
PURPOSE. DELL IS NOT LIABLE TO YOU FOR WARRANTIES, SUPPORT, OR SERVICE MADE BY OR 
PURCHASED FROM A THIRD PARTY AND NOT DIRECTLY FROM DELL. DELL IS NOT 
RESPONSIBLE FOR REPRESENTATIONS OR OMISSIONS MADE BY A THIRD PARTY.

10 Applicable Law; Not For Resale or Export. 

You agree to comply with all applicable laws and regulations of the various states and of the United States. You agree 
and represent that you are buying only for your own internal use only, and not for resale or export. Dell has separate 
terms and conditions governing resale of Product by third parties and transactions outside the United States. Terms 
and conditions for resale are located at: http://www.dell.com/policy/legal/termsofsale.htm. 

11 Governing Law. 

THIS AGREEMENT AND ANY SALES THERE UNDER SHALL BE GOVERNED BY THE LAWS OF THE 
STATE OF TEXAS, WITHOUT REGARD TO CONFLICTS OF LAWS RULES. 

12 Headings. 

The section headings used herein are for convenience of reference only and do not form a part of these terms and 
conditions, and no construction or inference shall be derived there from.

13 Binding Arbitration.

ANY CLAIM, DISPUTE, OR CONTROVERSY (WHETHER IN CONTRACT, TORT, OR OTHERWISE, 
WHETHER PREEXISTING, PRESENT OR FUTURE, AND INCLUDING STATUTORY, COMMON LAW, 
INTENTIONAL TORT AND EQUITABLE CLAIMS) BETWEEN CUSTOMER AND DELL, its agents, 
employees, principals, successors, assigns, affiliates (collectively for purposes of this paragraph, "Dell") arising from or 
relating to this Agreement, its interpretation, or the breach, termination or validity thereof, the relationships which 
result from this Agreement (including, to the full extent permitted by applicable law, relationships with third parties 
who are not signatories to this Agreement), Dell's advertising, or any related purchase SHALL BE RESOLVED 
EXCLUSIVELY AND FINALLY BY BINDING ARBITRATION ADMINISTERED BY THE NATIONAL 
ARBITRATION FORUM (NAF) under its Code of Procedure then in effect (available via the Internet at 
http://www.arb-forum.com , or via telephone at 1-800-474-2371). The arbitration will be limited solely to the 
dispute or controversy between customer and Dell. NEITHER CUSTOMER NOR DELL SHALL BE ENTITLED 
TO JOIN OR CONSOLIDATE CLAIMS BY OR AGAINST OTHER CUSTOMERS, OR ARBITRATE ANY CLAIM 
AS A REPRESENTATIVE OR CLASS ACTION OR IN A PRIVATE ATTORNEY GENERAL CAPACITY. This 
transaction involves interstate commerce, and this provision shall be governed by the Federal Arbitration Act 9 
U.S.C. sec. 1-16 (FAA). Any award of the arbitrator(s) shall be final and binding on each of the parties, and may be 
entered as a judgment in any court of competent jurisdiction. Dell will be responsible for paying any arbitration filing 
fees and fees required to obtain a hearing to the extent such fees exceed the amount of the filing fee for initiating a 
claim in the court of general jurisdiction in the state in which you reside. Each party shall pay for its own costs and 
attorneys' fees, if any. However, if any party prevails on a statutory claim that affords the prevailing party attorneys' 
fees, or if there is a written agreement providing for fees, the Arbitrator may award reasonable fees to the prevailing 
party, under the standards for fee shifting provided by law. Information may be obtained and claims may be filed with 
the NAF at P.O. Box 50191, Minneapolis, MN 55405. (REV 4/04)
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 Limited Warranties and Return Policy

Dell-branded hardware products purchased in the U.S. and Canada come with either a 90-day, 1-year, 2-year, 3-year, or 
4-year limited warranty. To determine which warranty came with your hardware product(s), see your packing slip or 
invoice. The following section describes the limited warranties and return policy for the U.S. and Canada.

Limited Warranty for Dell-Branded Hardware Products (U.S. Only)
Dell-branded hardware products purchased in the U.S. come with either a 90-day, 1-year, 2-year, 3-year, or 4-year limited 
warranty depending on the product purchased. To determine which warranty came with your hardware product(s), see 
your packing slip or invoice. 

What is covered by this limited warranty?
This limited warranty covers defects in materials and workmanship in your—our end-user customer's—Dell-branded 
hardware products, including Dell-branded peripheral products.

What is not covered by this limited warranty?
This limited warranty does not cover: 

• Software, including the operating system and software added to the Dell-branded hardware products through our 
factory-integration system, third-party software, or the reloading of software

• Non-Dell-branded and Solution Provider Direct products and accessories

• Problems that result from: 

– External causes such as accident, abuse, misuse, or problems with electrical power

– Servicing not authorized by Dell 

– Usage that is not in accordance with product instructions

– Failure to follow the product instructions or failure to perform preventive maintenance 

– Problems caused by using accessories, parts, or components not supplied by Dell

• Products with missing or altered Service Tags or serial numbers

• Products for which Dell has not received payment

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS 
WHICH VARY FROM STATE TO STATE (OR JURISDICTION TO JURISDICTION). DELL'S 
RESPONSIBILITY FOR MALFUNCTIONS AND DEFECTS IN HARDWARE IS LIMITED TO REPAIR AND 
REPLACEMENT AS SET FORTH IN THIS WARRANTY STATEMENT. ALL EXPRESS AND IMPLIED 
WARRANTIES FOR THE PRODUCT, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES 
AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE 
LIMITED IN TIME TO THE TERM OF THE LIMITED WARRANTY PERIOD REFLECTED ON YOUR 
PACKING SLIP OR INVOICE. NO WARRANTIES, WHETHER EXPRESS OR IMPLIED, WILL APPLY AFTER 
THE LIMITED WARRANTY PERIOD HAS EXPIRED. SOME STATES DO NOT ALLOW LIMITATIONS ON 
HOW LONG AN IMPLIED WARRANTY LASTS, SO THIS LIMITATION MAY NOT APPLY TO YOU.

WE DO NOT ACCEPT LIABILITY BEYOND THE REMEDIES PROVIDED FOR IN THIS LIMITED 
WARRANTY OR FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT 
LIMITATION, ANY LIABILITY FOR THIRD-PARTY CLAIMS AGAINST YOU FOR DAMAGES, FOR 
PRODUCTS NOT BEING AVAILABLE FOR USE, OR FOR LOST DATA OR LOST SOFTWARE. OUR 
LIABILITY WILL BE NO MORE THAN THE AMOUNT YOU PAID FOR THE PRODUCT THAT IS THE 
SUBJECT OF A CLAIM. THIS IS THE MAXIMUM AMOUNT FOR WHICH WE ARE RESPONSIBLE.
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SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

How long does this limited warranty last?
This limited warranty lasts for the time period indicated on your packing slip or invoice, except for the following 
Dell-branded hardware:

• Portable computer batteries carry a 1-year limited warranty.

• Projector lamps carry a 90-day limited warranty. 

• Memory carries a lifetime limited warranty. 

• Monitors carry the longer of either a 3-year limited warranty or the remainder of the warranty for the Dell™ 
computer to which the monitor will be connected.

• PDAs, MP3 players, earphones, remote inline controls, and AC adapters carry a 1-year limited warranty.

• Other add-on hardware carries the longer of either a 1-year limited warranty for new parts and a 90-day limited 
warranty for reconditioned parts or, for both new and reconditioned parts, the remainder of the warranty for the 
Dell computer on which such parts are installed.

The limited warranty on all Dell-branded products begins on the date of the packing slip or invoice. The warranty period 
is not extended if we repair or replace a warranted product or any parts. Dell may change the availability of limited 
warranties, at its discretion, but any changes will not be retroactive.

What do I do if I need warranty service? 
Before the warranty expires, please call us at the relevant number listed in the following table. Please also have your Dell 
Service Tag or order number available. 

Web Support support.dell.com/ContactUs/ContactUsHome.aspx?c
=us&l=en&s=gen

Individual Home Consumers: U.S. Only

Technical Support 1-800-624-9896

Customer Service 1-800-624-9897

Individual Home Consumers who purchased through an 
Employee Purchase Program:

Technical Support and Customer Service 1-800-822-8965

Home and Small Business Commercial Customers:

Technical Support and Customer Service 1-800-456-3355

Medium, Large, or Global Commercial Customers, 
Healthcare Customers, and Value-Added Resellers (VARs):

Technical Support and Customer Service 1-877-459-7278

Government and Education Customers: 

Technical Support and Customer Service 1-877-459-7278

Dell-Branded Memory 1-888-363-5150
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 What will Dell do?

During the 90 days of the 90-day limited warranty and the first year of all other limited warranties: During the 90 days 
of the 90-day limited warranty and the first year of all other limited warranties, we will repair any Dell-branded hardware 
products returned to us that prove to be defective in materials or workmanship. If we are not able to repair the product, 
we will replace it with a comparable product that is new or refurbished. 

When you contact us, we will issue a Return Material Authorization Number for you to include with your return. You 
must return the products to us in their original or equivalent packaging, prepay shipping charges, and insure the 
shipment or accept the risk if the product is lost or damaged in shipment. We will return the repaired or replacement 
products to you. We will pay to ship the repaired or replaced products to you if you use an address in the United States 
(excluding Puerto Rico and U.S. possessions and territories). Otherwise, we will ship the product to you freight collect.

If we determine that the issue is not covered under this warranty, we will notify you and inform you of service 
alternatives that are available to you on a fee basis.

NOTE: Before you ship the product(s) to us, make sure to back up the data on the hard drive(s) and any other storage 
device(s) in the product(s). Remove any confidential, proprietary, or personal information and removable media such as 
floppy disks, CDs, or PC Cards. We are not responsible for any of your confidential, proprietary, or personal information; lost 
or corrupted data; or damaged or lost removable media.

During the remaining years: For the remaining period of the limited warranty, we will replace any defective part with 
new or refurbished parts, if we agree that it needs to be replaced. When you contact us, we will require a valid credit card 
number at the time you request a replacement part, but we will not charge you for the replacement part as long as you 
return the original part to us within 30 days after we ship the replacement part to you. If we do not receive the original 
part within 30 days, we will charge to your credit card the then-current standard price for that part. 

We will pay to ship the part to you if you use an address in the United States (excluding Puerto Rico and U.S. 
possessions and territories). Otherwise, we will ship the part freight collect. We will also include a prepaid shipping 
container with each replacement part for your use in returning the replaced part to us. 

NOTE: Before you replace parts, make sure to back up the data on the hard drive(s) and any other storage device(s) in the 
product(s). We are not responsible for lost or corrupted data.

What if I purchased a service contract?
If your service contract is with Dell, service will be provided to you under the terms of the service agreement. Please refer 
to that contract for details on how to obtain service.

If you purchased through us a service contract with one of our third-party service providers, please refer to that contract 
for details on how to obtain service. 

How will you fix my product?
We use new and refurbished parts made by various manufacturers in performing warranty repairs and in building 
replacement parts and systems. Refurbished parts and systems are parts or systems that have been returned to Dell, 
some of which were never used by a customer. All parts and systems are inspected and tested for quality. Replacement 
parts and systems are covered for the remaining period of the limited warranty for the product you bought. Dell owns all 
parts removed from repaired products.

May I transfer the limited warranty?
Limited warranties on systems may be transferred if the current owner transfers ownership of the system and records the 
transfer with us. The limited warranty on Dell-branded memory may not be transferred. You may record your transfer by 
going to Dell's website: 

• If you are an Individual Home Consumer, go to www.dell.com/us/en/dhs/topics/sbtopic_015_ccare.htm 
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• If you are a Home Office, Small, Medium, Large, or Global Commercial Customer, go to 
www.dell.com/us/en/biz/topics/sbtopic_ccare_nav_015_ccare.htm 

• If you are a Government, Education, or Healthcare Customer, or an Individual Home Consumer who purchased 
through an Employee Purchase Program, go to www.dell.com/us/en/pub/topics/sbtopic_015_ccare.htm

If you do not have Internet access, call your customer care representative or call 1-800-624-9897. 

All requests to transfer ownership are at Dell's sole discretion. All such transfers will be subject to the terms and 
conditions of the original service or limited warranty agreement and Dell's terms and conditions of sale located at 
www.dell.com. Dell cannot guarantee the authenticity of the products, limited warranties, service or support, or the 
accuracy of the listings of products you purchase from a third party.

Total Satisfaction Return Policy (U.S. Only)
We value our relationship with you and want to make sure that you are satisfied with your purchases. That is why we 
offer a Total Satisfaction return policy for most products that you, the end-user customer, purchase directly from Dell. 
Under this policy, you may return to Dell products that you purchased directly from Dell for a credit or a refund of the 
purchase price paid, less shipping and handling and applicable return fees as follows: 

New Hardware Products and Accessories — Unless you have a separate agreement with Dell, all hardware, accessories, 
peripherals, parts, and unopened software still in its/their sealed package, excluding the products listed below, may be 
returned within twenty-one (21) days from the date on the packing slip or invoice. 

Exclusions from the foregoing return policy:

• New Dell PowerEdge™, Dell PowerConnect™, and Dell PowerVault™ products (excluding PowerVault 160T tape 
libraries) may be returned within thirty (30) days from the date on the packing slip or invoice, except that new 
PowerEdge SC servers and n series products purchased from the Small and Medium Business Sales Division may 
only be returned within fourteen (14) days from the date on the packing slip or invoice. 

• Application software or an operating system that has been installed by Dell may not be returned unless you return 
the entire computer under the 21-day return policy, if applicable to your purchase (if not applicable to your 
purchase, you may not return application software or an operating system).   

• Nondefective third-party and Dell-branded software, peripheral, electronics and accessory products (for example:  
televisions, printers, projectors, MP3 players, PDAs, battery chargers, un-preinstalled third-party software, wireless 
cards/access points/routers), including but not limited to those sold by or through Dell's "Software & Peripherals" 
or "Electronics & Accessories" groups, may be returned within twenty-one (21) days from the date on the packing 
slip or invoice, but a fifteen percent (15%) return fee may be deducted from any refund or credit. 

• Dell | EMC storage products, EMC-branded products, Unisys-branded products, PowerVault 160T tape libraries, 
enterprise software, non-Dell-branded enterprise products, software and/or software licenses, or any 
non-Dell-customized hardware and/or software product(s) may not be returned at any time.

Reconditioned or Refurbished Dell-Branded Hardware Products and Parts — All reconditioned or refurbished 
PowerEdge, PowerConnect, and PowerVault products may be returned within thirty (30) days from the date on the 
packing slip or invoice. All other reconditioned or refurbished Dell-branded hardware products and parts may be 
returned within fourteen (14) days of the date on the packing slip or invoice. 

How to Return — To return products, e-mail or call Dell customer service to receive a Credit Return Authorization 
Number within the return policy period applicable to the product you want to return. You must obtain a Credit Return 
Authorization Number in order to return the product. See "Contacting Dell" or "Getting Help" in your customer 
documentation (or go to www.dell.com/us/en/gen/contact.htm) to find the appropriate contact information for 
obtaining customer assistance.
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 You must ship the products to Dell within five (5) days of the date that Dell issues the Credit Return Authorization 

Number. You must also return the products to Dell in their original packaging, in as-new condition along with any 
media, documentation, and all other items that were included in the original shipment, prepay shipping charges, and 
insure the shipment or accept the risk of loss or damage during shipment. 

NOTE: Before you ship the product(s) to us, make sure to back up the data on the hard drive(s) and any other storage 
device(s) in the product(s). Remove any confidential, proprietary, or personal information and removable media such as 
floppy disks, CDs, or PC Cards. We are not responsible for any of your confidential, proprietary, or personal information; lost 
or corrupted data; or damaged or lost removable media.

Limited Warranty Terms for Dell-Branded Hardware Products (Canada Only)
Dell-branded hardware products purchased in Canada come with either a 90-day, 1-year, 2-year, 3-year, or 4-year limited 
warranty depending on the product purchased. To determine which warranty came with your hardware product(s), see 
your packing slip or invoice. 

What is covered by this limited warranty?
This limited warranty covers defects in materials and workmanship in your—our end-user customer's—Dell-branded 
hardware products, including Dell-branded peripheral products.

What is not covered by this limited warranty?
This limited warranty does not cover:

• Software, including the operating system and software added to the Dell-branded hardware products through our 
factory-integration system, or the reloading of the software

• Non–Dell-branded and Solution Provider Direct products and accessories

• Problems that result from:

– External causes such as accident, abuse, misuse, or problems with electrical power

– Servicing not authorized by Dell

– Usage that is not in accordance with product instructions

– Failure to follow the product instructions or failure to perform preventive maintenance 

– Problems caused by using accessories, parts, or components not supplied by Dell

• Products with missing or altered Service Tags or serial numbers

• Products for which Dell has not received payment

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS 
WHICH VARY FROM PROVINCE TO PROVINCE. DELL'S RESPONSIBILITY FOR MALFUNCTIONS AND 
DEFECTS IN PRODUCT IS LIMITED TO REPAIR AND REPLACEMENT AS SET FORTH IN THIS WARRANTY 
STATEMENT, FOR THE TERM OF THE WARRANTY PERIOD REFLECTED ON YOUR PACKING SLIP OR 
INVOICE. EXCEPT FOR THE EXPRESS WARRANTIES CONTAINED IN THIS WARRANTY STATEMENT, 
DELL DISCLAIMS ALL OTHER WARRANTIES AND CONDITIONS, EXPRESS OR IMPLIED, INCLUDING 
WITHOUT LIMITATION IMPLIED WARRANTIES AND CONDITIONS OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE, STATUTORY OR OTHERWISE. SOME PROVINCES DO NOT 
ALLOW THE EXCLUSION OF CERTAIN IMPLIED WARRANTIES OR CONDITIONS, OR LIMITATIONS ON 
HOW LONG AN IMPLIED WARRANTY OR CONDITION LASTS. THEREFORE, THE FOREGOING 
EXCLUSIONS AND LIMITATIONS MAY NOT APPLY TO YOU. 

WE DO NOT ACCEPT LIABILITY BEYOND THE REMEDIES PROVIDED FOR IN THIS WARRANTY 
STATEMENT OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, 
WITHOUT LIMITATION, ANY LIABILITY FOR THIRD-PARTY CLAIMS AGAINST YOU FOR DAMAGES, FOR 
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PRODUCTS NOT BEING AVAILABLE FOR USE, OR FOR LOST DATA OR LOST SOFTWARE. OUR LIABILITY 
WILL BE NO MORE THAN THE AMOUNT YOU PAID FOR THE PRODUCT THAT IS THE SUBJECT OF A 
CLAIM. THIS IS THE MAXIMUM AMOUNT FOR WHICH WE ARE RESPONSIBLE.

SOME PROVINCES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF SPECIAL, INDIRECT, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT 
APPLY TO YOU.

How long does this limited warranty last?
This limited warranty lasts for the time period indicated on your packing slip or invoice, except that the limited warranty 
on Dell-branded batteries lasts only 1 year and the limited warranty on the lamps for Dell-branded projectors lasts only 
90 days. The limited warranty begins on the date of the packing slip or invoice. The warranty period is not extended if 
we repair or replace a warranted product or any parts. Dell may change the terms and availability of limited warranties, 
at its discretion, but any changes will not be retroactive (that is, the warranty terms in place at the time of purchase will 
apply to your purchase).

What do I do if I need warranty service? 
Before the warranty expires, please call us at the relevant number listed in the following table. Please also have your Dell 
Service Tag or order number available.

What will Dell do?
During the 90 days of the 90-day limited warranty and the first year of all other limited warranties: During the 90 days 
of the 90-day limited warranty and the first year of all other limited warranties, we will repair any Dell-branded hardware 
products returned to us that prove to be defective in materials or workmanship. If we are not able to repair the product, 
we will replace it with a comparable product that is new or refurbished. 

Web Support support.dell.com/ContactUs/ContactUsHome.aspx?c
=us&l=en&s=gen

Individual Home Consumers; Home Office and Small 
Business Customers:

Canada Only

Technical Support and Customer Service 1-800-847-4096

Medium, Large, and Global Commercial Customers; 
Government, Education, and Healthcare Customers; and 
Value-Added Resellers (VARs):

Technical Support 1-800-387-5757

Customer Service 1-800-326-9463

Government or Education Customers, or Individual Home 
Consumers who purchased through an Employee Purchase 
Program:

Technical Support 1-800-387-5757

Customer Service 1-800-326-9463 (Extension 8221 for Individual 
Consumers)

Dell-Branded Memory 1-888-363-5150

Printers, Wireless, Projection Devices and TVs, Handhelds, 
and Digital Jukebox

1-877-335-5767
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 When you contact us, we will issue a Return Material Authorization Number for you to include with your return. You 

must return the products to us in their original or equivalent packaging, prepay shipping charges, and insure the 
shipment or accept the risk if the product is lost or damaged in shipment. We will return the repaired or replacement 
products to you. We will pay to ship the repaired or replaced products to you if you use an address in Canada. Otherwise, 
we will ship the product to you freight collect.

If we determine that the issue is not covered under this warranty, we will notify you and inform you of service 
alternatives that are available to you on a fee basis.

NOTE: Before you ship the product(s) to us, make sure to back up the data on the hard drive(s) and any other storage 
device(s) in the product(s). Remove any confidential, proprietary, or personal information and removable media such as 
floppy disks, CDs, or PC Cards. We are not responsible for any of your confidential, proprietary, or personal information; lost 
or corrupted data; or damaged or lost removable media.

During the remaining years following the first year of all limited warranties: We will replace any defective part with 
new or refurbished parts, if we agree that it needs to be replaced. When you contact us, we will require a valid credit card 
number at the time you request a replacement part, but we will not charge you for the replacement part as long as you 
return the original part to us within 30 days after we ship the replacement part to you. If we do not receive the original 
part within 30 days, we will charge to your credit card the then-current standard price for that part. 

We will pay to ship the part to you if you use an address in Canada. Otherwise, we will ship the part freight collect. We 
will also include a prepaid shipping container with each replacement part for your use in returning the replaced part 
to us. 

NOTE: Before you replace parts, make sure to back up the data on the hard drive(s) and any other storage device(s) in the 
product(s). We are not responsible for lost or corrupted data. 

What if I purchased a service contract?
If your service contract is with Dell, service will be provided to you under the terms of the service contract. Please refer 
to that contract for details on how to obtain service. Dell's service contracts can be found online at www.dell.ca or by 
calling Customer Care at 1-800-847-4096. If you purchased through us a service contract with one of our third-party 
service providers, please refer to that contract (mailed to you with your packing slip or invoice) for details on how to 
obtain service. 

How will you fix my product?
We use new and refurbished parts made by various manufacturers in performing warranty repairs and in building 
replacement parts and systems. Refurbished parts and systems are parts or systems that have been returned to Dell, 
some of which were never used by a customer. All parts and systems are inspected and tested for quality. Replacement 
parts and systems are covered for the remaining period of the limited warranty for the product you bought. Dell owns all 
parts removed from repaired products. 

May I transfer the limited warranty?
Limited warranties on systems may be transferred if the current owner transfers ownership of the system and records the 
transfer with us. The limited warranty on Dell-branded memory may not be transferred. You may record your transfer by 
going to Dell’s website.

• For Canada-purchased computers (in-country transfers) and to transfer from one customer to another, go to 
www.dell.ca/ca/en/gen/topics/segtopic_ccare_nav_013_ccare.htm

• For out-of-country transfers (outside of the original country of purchase), go to 
www.dell.com/us/en/biz/topics/sbtopic_ccare_nav_016_ccare.htm

If you do not have Internet access, call Dell at 1-800-847-4096 (Home Consumer customers) or 1-800-326-9463 
(Corporate Commercial or Government customers).
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All requests to transfer ownership are at Dell's sole discretion. All such transfers will be subject to the terms and 
conditions of the original service or limited warranty agreement and Dell's terms and conditions of sale located at 
www.dell.com. Dell cannot guarantee the authenticity of the products, limited warranties, service or support, or the 
accuracy of the listings of products you purchase from a third party.

Total Satisfaction Return Policy (Canada Only)
If you are an end-user customer who bought new products directly from Dell, you may return them to Dell up to 30 days 
after you receive them for a refund or credit of the product purchase price. If you are an end-user customer who bought 
reconditioned or refurbished products from Dell, you may return them to Dell within 14 days after the date on the 
packing slip or invoice for a refund or credit of the product purchase price. In either case, the refund or credit will not 
include any shipping and handling charges shown on your packing slip or invoice and will be subject to a fifteen percent 
(15%) restocking fee, unless otherwise prohibited by law. If you are an organization that bought the products under a 
written agreement with Dell, the agreement may contain different terms for the return of products than specified by this 
policy. 

To return products, you must call Dell Customer Service at 1-800-847-4096 to receive a Credit Return Authorization 
Number. To expedite the process of your refund or credit, Dell expects you to return the products to Dell in their 
original packaging within 5 days of the date that Dell issues the Credit Return Authorization Number. You must also 
prepay shipping charges and insure the shipment or accept the risk of loss or damage during shipment. You may return 
software for a refund or credit only if the sealed package containing the diskette(s) or CD(s) is unopened. Returned 
products must be in as-new condition, and all of the manuals, diskette(s), CD(s), power cables, and other items 
included with a product must be returned with it. For customers who want to return, for refund or credit only, either 
application or operating system software that has been installed by Dell, the whole system must be returned, along with 
any media and documentation that may have been included in the original shipment. 

The "Total Satisfaction" Return Policy does not apply to Dell | EMC storage products. It also does not apply to products 
purchased through Dell's Software and Peripherals division. For those products, please instead refer to Dell's Software 
and Peripheral's then-current return policy (see the following section, "Dell Software and Peripherals [Canada Only]"). 

Dell™ Software and Peripherals (Canada Only)

Third-Party Software and Peripherals Products
Similar to other resellers of software and peripherals, Dell does not warrant third-party products. Third-party software 
and peripheral products are covered by the warranties provided by the original manufacturer or publisher only. 
Third-party manufacturer warranties vary from product to product. Consult your product documentation for specific 
warranty information. More information may also be available from the manufacturer or publisher.

While Dell offers a wide selection of software and peripheral products, we do not specifically test or guarantee that all of 
the products we offer work with any or all of the various models of Dell computers, nor do we test or guarantee all of the 
products we sell on the hundreds of different brands of computers available today. If you have questions about 
compatibility, we recommend and encourage you to contact the third-party software and peripheral product 
manufacturer or publisher directly.

Dell-Branded Peripheral Products
Dell does provide a limited warranty for new Dell-branded peripheral products (products for which Dell is listed as the 
manufacturer) such as monitors, batteries, memory, docking stations, and projectors. To determine which limited 
warranty applies to the product you purchased, see the Dell packing slip or invoice and/or the product documentation 
that accompanied your product. Descriptions of Dell's limited warranties are described in preceding sections. 
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 1-Year End-User Manufacturer Guarantee (Latin America and the Caribbean Only)

Guarantee
Dell Inc. ("Dell") warrants to the end user in accordance with the following provisions that its branded hardware 
products, purchased by the end user from a Dell company or an authorized Dell distributor in Latin America or the 
Caribbean, will be free from defects in materials, workmanship, and design affecting normal use, for a period of 1 year 
from the original purchase date. Products for which proper claims are made will, at Dell’s option, be repaired or replaced 
at Dell’s expense. Dell owns all parts removed from repaired products. Dell uses new and reconditioned parts made by 
various manufacturers in performing repairs and building replacement products.

Exclusions
This Guarantee does not apply to defects resulting from: improper or inadequate installation, use, or maintenance; 
actions or modifications by unauthorized third parties or the end user; accidental or willful damage; or normal wear and 
tear.

Making a Claim
Claims must be made in Latin America or the Caribbean by contacting the Dell point of sale within the guarantee 
period. The end user must always supply proof of purchase, indicating name and address of the seller, date of purchase, 
model and serial number, name and address of the customer, and details of symptoms and configuration at the time of 
malfunction, including peripherals and software used. Otherwise, Dell may refuse the guarantee claim. Upon diagnosis 
of a warranted defect, Dell will make arrangements and pay for ground freight and insurance to and from Dell’s 
repair/replacement center. The end user must ensure that the defective product is available for collection properly 
packed in original or equally protective packaging together with the details listed above and the return number provided 
to the end user by Dell.

Limitation and Statutory Rights
Dell makes no other warranty, guarantee or like statement other than as explicitly stated above, and this Guarantee is 
given in place of all other guarantees whatsoever, to the fullest extent permitted by law. In the absence of applicable 
legislation, this Guarantee will be the end user’s sole and exclusive remedy against Dell or any of its affiliates, and 
neither Dell nor any of its affiliates shall be liable for loss of profit or contracts, or any other indirect or consequential 
loss arising from negligence, breach of contract, or howsoever. 

This Guarantee does not impair or affect mandatory statutory rights of the end user against and/or any rights resulting 
from other contracts concluded by the end user with Dell and/or any other seller.

Dell World Trade LP
One Dell Way, Round Rock, TX 78682, USA

Dell Computadores do Brasil Ltda (CNPJ No. 72.381.189/0001-10)
Avenida Industrial Belgraf, 400
92990-000 - Eldorado do Sul – RS - Brasil

Dell Computer de Chile Ltda
Coyancura 2283, Piso 3- Of.302,
Providencia, Santiago - Chile

Dell Computer de Colombia Corporation
Carrera 7 #115-33 Oficina 603
Bogota, Colombia
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Dell Computer de Mexico SA de CV
Paseo de la Reforma 2620 - 11° Piso
Col. Lomas Altas 
11950 México, D.F.

Dell™ Printer Consumables Limited Warranties
The following sections describe the limited warranty for printer consumables (ink cartridges, toner cartridges, photo 
print packs, and photo paper) for Dell-branded printers, for the U.S., Canada, and Latin America. Refer to the 
appropriate limited warranty accordingly.

Consumables Limited Warranty (U.S. and Canada Only)
Dell Inc. warrants to the original purchaser of genuine Dell-branded toner cartridges that they will be free from defects 
in material and workmanship for the life of the cartridge and that for genuine Dell-branded ink cartridges, photo print 
packs and photo paper, they will be free from defects in material and workmanship for two years beginning on the date 
of invoice. If this product proves defective in either material or workmanship, it will be replaced without charge during 
the limited warranty period if returned to Dell. You must first call our toll-free number to get your return authorization. 
In the U.S., call 1-800-822-8965; in Canada, call 1-800-387-5757. If we are not able to replace the product because it has 
been discontinued or is not available, we will either replace it with a comparable product or reimburse you for the 
cartridge purchase cost, at Dell’s sole option. This limited warranty does not apply to ink or toner cartridges that have 
been refilled or improperly stored or due to problems resulting from misuse, abuse, accident, neglect, mishandling, 
incorrect environments, or wear from ordinary use.

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS 
WHICH VARY FROM STATE TO STATE (OR JURISDICTION TO JURISDICTION). DELL’S RESPONSIBILITY 
FOR MALFUNCTIONS AND DEFECTS IN HARDWARE IS LIMITED TO REPLACEMENT AS SET FORTH IN 
THIS WARRANTY STATEMENT. FOR CANADIAN CUSTOMERS, EXCEPT FOR THE EXPRESS WARRANTIES 
CONTAINED IN THIS WARRANTY STATEMENT, DELL DISCLAIMS ALL OTHER WARRANTIES AND 
CONDITIONS, EXPRESS OR IMPLIED, STATUTORY OR OTHERWISE, FOR THE PRODUCT. FOR U.S. 
CUSTOMERS, ALL EXPRESS AND IMPLIED WARRANTIES FOR THE PRODUCT, INCLUDING BUT NOT 
LIMITED TO ANY IMPLIED WARRANTIES AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE ARE LIMITED IN TIME TO THE TERM OF THIS LIMITED WARRANTY. NO 
WARRANTIES, WHETHER EXPRESS OR IMPLIED, WILL APPLY AFTER THE LIMITED WARRANTY PERIOD 
HAS EXPIRED. SOME STATES OR JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF CERTAIN 
IMPLIED WARRANTIES OR CONDITIONS, OR LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY OR 
CONDITION LASTS, SO THIS LIMITATION MAY NOT APPLY TO YOU. THIS WARRANTY COVERAGE 
TERMINATES IF YOU SELL OR OTHERWISE TRANSFER THIS PRODUCT TO ANOTHER PARTY.

DELL DOES NOT ACCEPT LIABILITY BEYOND THE REMEDIES PROVIDED FOR IN THIS LIMITED 
WARRANTY OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES, INCLUDING, 
WITHOUT LIMITATION, ANY LIABILITY FOR THIRD-PARTY CLAIMS AGAINST YOU FOR DAMAGES, FOR 
PRODUCTS NOT BEING AVAILABLE FOR USE, OR FOR LOST DATA OR LOST SOFTWARE. DELL’S 
LIABILITY WILL BE NO MORE THAN THE AMOUNT YOU PAID FOR THE PRODUCT THAT IS THE 
SUBJECT OF A CLAIM. THIS IS THE MAXIMUM AMOUNT FOR WHICH DELL IS RESPONSIBLE.

SOME STATES OR JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF SPECIAL, 
INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION 
MAY NOT APPLY TO YOU.
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 Consumables Limited Warranty (Latin America Only)

Dell Inc. warrants to the original purchaser of genuine Dell-branded toner cartridges that the cartridges will be free from 
defects resulting from material or manufacturing process for the life of the cartridge. For the original purchaser of 
genuine Dell-branded ink cartridges, photo print packs and photo paper, Dell warrants that the consumables will be free 
from defects resulting from material or manufacturing process for one year beginning from the date of delivery.

If this product presents defects resulting from either material or manufacturing process, it will be replaced without 
charge during the limited warranty period if returned to Dell.

In order to obtain the necessary information to enable the replacement, call the appropriate toll-free number. In Mexico, 
call 001-877-533-6230; in Puerto Rico, call 1-877-839-5123. In cases in which either the production of the cartridge has 
been discontinued or the cartridge is not available, Dell reserves the right, at its sole discretion, to choose between 
replacing it by a similar product or reimbursing you for the purchase cost.

This limited warranty does not apply to ink or toner cartridges that have been refilled or to defects resulting from 
misuse, abuse, accident, negligence, mishandling, improper storage or exposure to inappropriate environments.

Dell’s liability for the malfunction or defect of hardware after the period of the legal warranty (and specifically the 
period of the legal warranty of defective products stated in the consumer protections rules), is limited to either the 
substitution of the product or the reimbursement as stated above. This warranty coverage terminates if you sell or 
otherwise transfer this product to a third party. 

Dell does not accept any additional liability for patrimonial, emotional or any other kind of damage caused to the 
consumer and/or to a third party, which exceeds the established liability either in this limited warranty or in legal rules 
that may apply.

Export Regulations
Customer acknowledges that these Products, which may include technology and software, are subject to the customs 
and export control laws and regulations of the United States (“U.S.”) and may also be subject to the customs and export 
laws and regulations of the country in which the Products are manufactured and/or received. Customer agrees to abide 
by those laws and regulations. Further, under U.S. law, the Products may not be sold, leased or otherwise transferred to 
restricted end-users or to restricted countries. In addition, the Products may not be sold, leased or otherwise transferred 
to, or utilized by an end-user engaged in activities related to weapons of mass destruction, including without limitation, 
activities related to the design, development, production or use of nuclear weapons, materials, or facilities, missiles or 
the support of missile projects, and chemical or biological weapons.

Dell™ Software License Agreement
This is a legal agreement between you, the user, and Dell Products, L.P ("Dell"). This agreement covers all software that 
is distributed with the Dell product, for which there is no separate license agreement between you and the manufacturer 
or owner of the software (collectively the "Software"). This agreement is not for the sale of Software or any other 
intellectual property. All title and intellectual property rights in and to Software is owned by the manufacturer or owner 
of the Software. All rights not expressly granted under this agreement are reserved by the manufacturer or owner of the 
Software. By opening or breaking the seal on the Software packet(s), installing or downloading the Software, or using the 
Software that has been preloaded or is embedded in your product, you agree to be bound by the terms of this agreement. 
If you do not agree to these terms, promptly return all Software items (disks, written materials, and packaging) and 
delete any preloaded or embedded Software.

You may use one copy of the Software on only one product at a time. If you have multiple licenses for the Software, you 
may use as many copies at any time as you have licenses. "Use" means loading the Software in temporary memory or 
permanent storage on the product. Installation on a network server solely for distribution to other products is not "use" 
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if (but only if) you have a separate license for each product to which the Software is distributed. You must ensure that 
the number of persons using the Software installed on a network server does not exceed the number of licenses that you 
have. If the number of users of Software installed on a network server will exceed the number of licenses, you must 
purchase additional licenses until the number of licenses equals the number of users before allowing additional users to 
use the Software. If you are a commercial customer of Dell or a Dell affiliate, you hereby grant Dell, or an agent selected 
by Dell, the right to perform an audit of your use of the Software during normal business hours, you agree to cooperate 
with Dell in such audit, and you agree to provide Dell with all records reasonably related to your use of the Software. The 
audit will be limited to verification of your compliance with the terms of this agreement.

The Software is protected by United States copyright laws and international treaties. You may make one copy of the 
Software solely for backup or archival purposes or transfer it to a single hard disk provided you keep the original solely for 
backup or archival purposes. You may not rent or lease the Software or copy the written materials accompanying the 
Software, but you may transfer the Software and all accompanying materials on a permanent basis as part of a sale or 
transfer of the Dell product if you retain no copies and the recipient agrees to the terms hereof. Any transfer must 
include the most recent update and all prior versions. You may not reverse engineer, decompile, or disassemble the 
Software. If the package accompanying your product contains compact discs, 3.5", and/or 5.25" disks, you may use only 
the disks appropriate for your product. You may not use the disks on another computer or network, or loan, rent, lease, or 
transfer them to another user except as permitted by this agreement.

Limited Warranty
Dell warrants that the Software disks will be free from defects in materials and workmanship under normal use for 
ninety (90) days from the date you receive them. This warranty is limited to you and is not transferable. Any implied 
warranties are limited to ninety (90) days from the date you receive the Software. Some jurisdictions do not allow limits 
on the duration of an implied warranty, so this limitation may not apply to you. The entire liability of Dell and its 
suppliers, and your exclusive remedy, shall be (a) return of the price paid for the Software or (b) replacement of any disk 
not meeting this warranty that is sent with a return authorization number to Dell, at your cost and risk. This limited 
warranty is void if any disk damage has resulted from accident, abuse, misapplication, or service or modification by 
someone other than Dell. Any replacement disk is warranted for the remaining original warranty period or thirty 
(30) days, whichever is longer.

Dell does NOT warrant that the functions of the Software will meet your requirements or that operation of the Software 
will be uninterrupted or error free. You assume responsibility for selecting the Software to achieve your intended results 
and for the use and results obtained from the Software.

DELL, ON BEHALF OF ITSELF AND ITS SUPPLIERS, DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE, FOR THE SOFTWARE AND ALL ACCOMPANYING WRITTEN 
MATERIALS. This limited warranty gives you specific legal rights; you may have others, which vary from jurisdiction to 
jurisdiction.

IN NO EVENT SHALL DELL OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES WHATSOEVER 
(INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS 
INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR OTHER PECUNIARY LOSS) ARISING OUT OF 
USE OR INABILITY TO USE THE SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. Because some jurisdictions do not allow an exclusion or limitation of liability for consequential or 
incidental damages, the above limitation may not apply to you.
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 U.S. Government Restricted Rights

The software and documentation are "commercial items" as that term is defined at 48 C.F.R. 2.101, consisting of 
"commercial computer software" and "commercial computer software documentation" as such terms are used in 48 
C.F.R. 12.212. Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4, all U.S. Government end 
users acquire the software and documentation with only those rights set forth herein. Contractor/manufacturer is Dell 
Products, L.P., One Dell Way, Round Rock, Texas 78682.

General
This license is effective until terminated. It will terminate upon the conditions set forth above or if you fail to comply 
with any of its terms. Upon termination, you agree that the Software and accompanying materials, and all copies 
thereof, will be destroyed. This agreement is governed by the laws of the State of Texas. Each provision of this 
agreement is severable. If a provision is found to be unenforceable, this finding does not affect the enforceability of the 
remaining provisions, terms, or conditions of this agreement. This agreement is binding on successors and assigns. Dell 
agrees and you agree to waive, to the maximum extent permitted by law, any right to a jury trial with respect to the 
Software or this agreement. Because this waiver may not be effective in some jurisdictions, this waiver may not apply to 
you. You acknowledge that you have read this agreement, that you understand it, that you agree to be bound by its 
terms, and that this is the complete and exclusive statement of the agreement between you and Dell regarding the 
Software.

Regulatory Notices
Electromagnetic Interference (EMI) is any signal or emission, radiated in free space or conducted along power or signal 
leads, that endangers the functioning of a radio navigation or other safety service or seriously degrades, obstructs, or 
repeatedly interrupts a licensed radio communications service. Radio communications services include but are not 
limited to AM/FM commercial broadcast, television, cellular services, radar, air-traffic control, pager, and Personal 
Communication Services (PCS). These licensed services, along with unintentional radiators such as digital devices, 
including computers, contribute to the electromagnetic environment.

Electromagnetic Compatibility is the ability of items of electronic equipment to function properly together in the 
electronic environment. While this product has been designed and determined to be compliant with regulatory agency 
limits for EMI, there is no guarantee that interference will not occur in a particular installation. If this equipment does 
cause interference with radio communications services, which can be determined by turning the equipment off and on, 
you are encouraged to try to correct the interference by one or more of the following measures:

• Reorient the receiving antenna.

• Relocate the product with respect to the receiver.

• Move the product away from the receiver.

• Plug the product into a different outlet so that the product and the receiver are on different branch circuits.

If necessary, consult a Dell Technical Support representative or an experienced radio/television technician for additional 
suggestions. 

Dell™ products are designed, tested, and classified for their intended electromagnetic environment. These 
electromagnetic environment classifications generally refer to the following harmonized definitions:

• Class A is typically for business or industrial environments.

• Class B is typically for residential environments.

Information Technology Equipment (ITE), including devices, expansion cards, printers, input/output (I/O) devices, 
monitors, and so on, that are integrated into or connected to the product should match the electromagnetic 
environment classification of the product.
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A Notice About Shielded Signal Cables: Use only shielded cables for connecting devices to any Dell device to reduce 
the possibility of interference with radio communications services. Using shielded cables ensures that you maintain 
the appropriate Electromagnetic Compatibility classification for the intended environment. For parallel printers, a 
cable is available from Dell. If you prefer, you can order a cable from Dell on the World Wide Web at 
www.dell.com/supplies.

Most Dell products are classified for Class B environments. However, the inclusion of certain options may change the 
rating of some configurations to Class A. To determine the electromagnetic classification for your computer or device, 
see the following sections specific for each regulatory agency. Each section provides country-specific Electromagnetic 
Compatibility/EMI, telecommunications, wireless, or product safety information.

FCC Notices (U.S. Only)
For FCC information, see the appropriate documentation for your product: Dell printer User’s Guide.

NOM Information (Mexico Only)
The following information is provided on the device(s) described in this document in compliance with the requirements 
of the official Mexican standards (NOM):

Exporter: Dell Inc.
One Dell Way
Round Rock, TX 78682

Importer: Dell Computer de México, S.A. de C.V. 
Paseo de la Reforma 2620 - 11° Piso 
Col. Lomas Altas 
11950 México, D.F. 

Ship to: Dell Computer de México, S.A. de C.V. 
al Cuidado de Kuehne & Nagel de México S. de R.L.
Avenida Soles No. 55
Col. Peñon de los Baños
15520 México, D.F.

Model number:

Supply voltage:

Frequency:

Current consumption:

Output voltage:

Output current:
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Index

B
booklets, printing, 51

C
canceling a print job, 54

D
Dell

contacting, 69

Dell Toner Management 
System, 41

Driver Profiler, 43

duplex, printing, 49

F
firewall, disabling, 37

I
imaging drum, replacing, 59

installing
optional drawer, 13
optional memory, 16

installing local printer drivers
Linux, 27

Macintosh, 34
Windows 2000, 31
Windows 2003 Server, 30
Windows 98 SE, 33
Windows Me, 32
Windows NT, 32
Windows XP, 29
Windows XP Professional 

x64, 28

L
letterhead

loading, 53
printing, 53

loading paper
manual feeder, 22
optional tray, 19
standard tray, 19

Local Printer Settings 
Utility, 42

M
manual feeder, loading, 22

media types and sizes, 24

multiple page printing, 50

N
N-up printing, 50

O
operator panel, 12

operator panel lights, 12

optional drawer, installing, 13

optional memory, 
installing, 16

P
paper trays, loading, 19

posters, printing, 52

Printer Configuration Web 
Tool, 44

printer drivers, local
Linux, 27
Macintosh, 34
Windows 2000, 31
Windows 2003 Server, 30
Windows 98 SE, 33
Windows Me, 32
Windows NT, 32
Windows XP, 29
Windows XP Professional 

x64, 28
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Printer Software Uninstall, 43

Printer Supplies Reorder 
Application, 42

printing, 47
booklets, 51
canceling a print job, 54
duplex, 49
letterhead, 53
local, 27
manual feed, 47
multi-page (N-up), 50
network, 37
network setup page, 37
posters, 52

R
rear exit, using, 23

S
Set IP Address Utility, 42

software applications
Dell Toner Management 

System, 41
Driver Profiler, 43
Local Printer Settings 

Utility, 42
Printer Configuration Web 

Tool, 44
Printer Software Uninstall, 43
Printer Supplies Reorder 

Application, 42
Set IP Address Utility, 42
Status Monitor Center, 41

Status Monitor Center, 41

support
contacting Dell, 69

T
toner cartridge, replacing, 55

U
uninstall software, 43

W
warranty, 92, 104

Windows XP firewall, 
disabling, 37
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